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About This Manual 

This manual provides instructions for the installation, use and maintenance of the 
Spectrum Two N spectrometer. It contains the following sections: 

• Introduction 

• Warnings and Safety Information 

• An Overview of the Spectrum Two N 

• Unpacking and Installation 

• Getting Started with Spectrum Software 

• Maintenance 

• Appendices. 

NOTE: This manual shows details for using your instrument with the Spectrum software 
package (version 10.6 or later). If you have Spectrum ES or AssureID software, 
please refer to the Administrator’s Guide for your software, which can be found on 
the Spectrum Two Manuals CD (part number L1050242), or refer to the on-screen 
Help. 

For further information on collecting, viewing and processing spectra using Spectrum 
software, refer to the help file that you can access from the Help menu, or by clicking Help 
on a dialog. 
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Conventions Used in this Manual 
Normal text is used to provide information and instructions. 

Bold text refers to text that is displayed on the screen. 

UPPERCASE text, for example ENTER or ALT, refers to keys on the PC keyboard. “+” is 
used to show that you have to press two keys at the same time, for example, ALT+F. 

All eight-digit numbers are PerkinElmer part numbers unless stated otherwise. 

The term “instrument” refers to either the Spectrum Two N FT-NIR spectrometer, and any 
sampling accessory fitted. 

Notes, Cautions and Warnings 
Three terms, in the following standard formats, are also used to highlight special 
circumstances and warnings. 

NOTE: A note indicates additional, significant information that is provided with some 
procedures. 
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WARNING 

 
We use the term WARNING to inform you about situations that could 
result in personal injury to yourself or other persons. Details about 
these circumstances are in a box like this one. 

 

Warning (Warnung) 

Bedeutet, daß es bei Nichtbeachten der genannten Anweisung zu einer 
Verletzung des Benutzers kommen kann. 

 
Warning (Advarsel) 

Betyder, at brugeren kan blive kvæstet, hvis anvisningen ikke overholdes. 

 
Warning (Peligro) 

Utilizamos el término WARNING (PELIGRO) para informarle sobre 
situaciones que pueden provocar daños personales a usted o a otras 
personas. En los recuadros como éste se proporciona información sobre este 
tipo de circunstancias. 

 

Warning (Danger) 

Nous utilisons la formule WARNING (DANGER) pour avertir des situations 
pouvant occasionner des dommages corporels à l'utilisateur ou à d'autres 
personnes. Les détails sur ces circonstances sont données dans un encadré 
semblable à celui-ci. 

 
Warning (Pericolo) 

Con il termine WARNING (PERICOLO) vengono segnalate situazioni che 
potrebbero provocare incidenti alle persone. Troverete informazioni su tali 
circostanze in un riquadro come questo. 

 
Warning (Waarschuwing) 

Betekent dat, wanneer de genoemde aanwijzing niet in acht wordt genomen, 
dit kan leiden tot verwondingen van de gebruiker. 

 
Warning (Aviso) 

Significa que a não observância da instrução referida poderá causar um 
ferimento ao usuário. 

 
Warning (警告) 

我们使用“警告”这一术语来通知您有关可能会对您自己或他人造成人 
身伤害的情况。 
有关这些情况的详细信息可在此类方框中找到。 

 
Warning (警告) 

使用者及びその他周辺に危害が及ぶ恐れがある場合は、 
この様なボックスの中に注意事項が表示されています。 
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CAUTION 

 
We use the term CAUTION to inform you about situations that could 
result in serious damage to the instrument or other equipment. 
Details about these circumstances are in a box like this one. 

 

Caution (Achtung) 
Bedeutet, daß die genannte Anleitung genau befolgt werden muß, um einen 
Geräteschaden zu vermeiden. 

 
Caution (Bemærk) 
Dette betyder, at den nævnte vejledning skal overholdes nøje for at undgå en 
beskadigelse af apparatet. 

 
Caution (Advertencia) 
Utilizamos el término CAUTION (ADVERTENCIA) para advertir sobre 
situaciones que pueden provocar averías graves en este equipo o en otros. En 
los recuadros como éste se proporciona información sobre este tipo de 
circunstancias. 

 
Caution (Attention) 
Nous utilisons le terme CAUTION (ATTENTION) pour signaler les situations 
susceptibles de provoquer de graves détériorations de l'instrument ou 
d'autre matériel. Les détails sur ces circonstances figurent dans un encadré 
semblable à celui-ci. 

 
Caution (Attenzione) 
Con il termine CAUTION (ATTENZIONE) vengono segnalate situazioni che 
potrebbero arrecare gravi danni allo strumento o ad altra apparecchiatura. 
Troverete informazioni su tali circostanze in un riquadro come questo. 

 
Caution (Opgelet) 
Betekent dat de genoemde handleiding nauwkeurig moet worden opgevolgd, 
om beschadiging van het instrument te voorkomen. 

 
Caution (Atenção) 
Significa que a instrução referida tem de ser respeitada para evitar a 
danificação do aparelho. 

 
Caution (小心) 

我们使用“小心”这一术语来通知您有关可能会对 
本仪器或其它设备造成严重损害的情况。 
有关这些情况的详细信息可在此类方框中找到。 

 
Caution (注意) 

分光器や他の機材等に深刻なダメージを与える恐れがある場合は、 
この様なボックスの中に表示しています。 
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Overview 

This chapter describes the general safety practices and precautions that must be observed 
when operating the Spectrum Two N FT-NIR spectrometer.  

This advice is intended to supplement, not supersede, the normal safety codes in the user's 
country. It is also a supplement to the PerkinElmer standard Safety and Health Policy. The 
information provided does not cover every safety procedure that should be practiced. 
Ultimately, maintenance of a safe laboratory environment is the responsibility of the analyst 
and the analyst's organization.  

Please consult all manuals supplied with the Spectrum Two N and accessories before you 
start working with the instrument. Carefully read the safety information in this chapter and in 
the other manuals supplied. When setting up the instrument or performing analyses or 
maintenance procedures, strictly follow the instructions provided.  
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Safety Summary 

The Spectrum Two N FT-NIR spectrometers have been designed to comply with a wide 
variety of international standards governing the safety of laboratory equipment. In routine 
use, the instruments pose virtually no risk to you. If you take some simple, common-sense 
precautions, you can make sure that you maintain the continued safe operation of your 
instrument: 

• DO make sure that the power supply is properly connected to the electrical supply; in 
particular make sure that the ground (earth) is securely connected. 

• DO disconnect the electrical power cable before opening any ports or covers on the 
instrument, unless otherwise directed in the maintenance procedures described in this 
manual, or in Spectrum, Spectrum ES or AssureID software. 

• DO NOT open the main instrument cover. There are no user-serviceable parts inside the 
main cover, and tampering with the seal will invalidate your warranty. 

• DO keep the instrument dry. Avoid spilling liquid onto the instrument. Clean all external 
spills immediately.  

• DO NOT use a flammable gas to purge the instrument. The instrument contains a hot 
source, and a fire or explosion will result. Only use clean, dry, oil-free nitrogen or air to 
purge the instrument. 

• DO read the more detailed information on warnings and safety in the following pages to 
ensure the safe operation of the instrument. 
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General Safety 

The Spectrum Two N FT-NIR spectrometers have been designed and tested in accordance 
with PerkinElmer specifications and in accordance with the safety requirements of the 
International Electrotechnical Commission (IEC). The instruments conform to IEC publication 
61010-1 (“Safety requirements for electrical equipment for measurement, control, and 
laboratory use”) and therefore meets the requirements of EC low voltage directive 
2006/95/EC. 

If the instrument is used in a manner not specified by the manufacturer, the protection 
provided by the instrument may be impaired. Only use the instrument under the following 
environmental conditions: 

Temperature  4 °C to 45 °C 
Relative Humidity 90% maximum (non-condensing) 

 

 
WARNING 

AVERTISSEMENT 

If the equipment is used in a manner not specified herein the 
protection provided by the equipment may be impaired. 

Si l'équipement est utilisé d'une manière non spécifiée ici, la protection 
fournie par l'équipement peut être altérée. 

Electrical safety 

• Connect the instrument power supply to a power outlet that includes a switch or other 
means of disconnection from the electricity supply. 

• Only plug the instrument power supply into a socket power outlet that is provided with 
a protective earth connection. 

• The instrument must be disconnected from all voltage sources before it is opened for 
any adjustment, replacement, maintenance or repair, unless otherwise directed in the 
maintenance procedures described in this manual, or in Spectrum, Spectrum ES or 
AssureID software. 
 

 
WARNING 

 
AVERTISSEMENT 

To ensure safe and satisfactory operation of the instrument, it is 
essential that the green or green/yellow ground (earth) wire of the 
power cord is connected to a ground that complies with the regulations 
of the local electricity supply authority (or equivalent body); ground 
circuit continuity is essential for safe operation of the equipment. 

Pour assurer un fonctionnement sûr et satisfaisant de l'instrument, il 
est essentiel que le fil de terre vert ou vert / terre du cordon 
d'alimentation soit raccordé à un sol conforme à la réglementation de 
l'autorité locale d'alimentation électrique (ou du corps équivalent) ; La 
continuité du circuit au sol est essentielle pour un fonctionnement sûr 
de l'équipement. 

Only connect equipment that meets the requirements of IEC 61010-1, IEC 60950 or 
equivalent standards. 
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A Spectrum Two N has: 

• An IEC Installation Category (Overvoltage Category) II classification - suitable for 
connection to local level power supplies. 

• An IEC Pollution Degree 2 classification - usually only non-conductive atmospheric 
pollution of the equipment occurs; occasionally, however, a temporary conductivity 
caused by condensation must be expected. 

The power supply adaptor has been designed to be safe under the following environmental 
conditions: 

• Indoor use 

• Altitude up to 2000 m (above mean sea level) 

• Ambient temperatures of 0 °C to 50 °C 

• Mains supply fluctuations not exceeding ±10% of the nominal voltage. 

If it is necessary to fit a plug on the power cable supplied, use the wire color code below: 
 

Plug Pin Wire Color (100–120 V) Wire Color (220–240 V) 

Ground (Earth) Green or Green/Yellow Green/Yellow 

Live Black Brown 

Neutral White Blue 

Optical radiation 

The instrument complies with the requirements of the Artificial Optical Radiation Directive 
2006/25/EC. 
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Location and Ventilation 

To allow for adequate cooling 

• Do not site the instrument near to room-heating equipment, for example,  
central-heating radiators. 

• Do not block the ventilation cooling holes under the instrument. 

• Do not cover the power supply adaptor. 

To allow any nitrogen used to disperse  
 

 
WARNING 

 

AVERTISSEMENT 

Do not site the instrument in a poorly ventilated area if nitrogen will be 
used as a purge gas. 
 
Oxygen depletion in an enclosed space does not trigger a gasping 
reflex, and errors of judgment, confusion, or unconsciousness can 
occur in seconds and without warning. 
 

Ne placez pas l'instrument dans une zone mal ventilée si l'azote est 
utilisé comme gaz de purge. 

L'appauvrissement de l'oxygène dans un espace clos ne déclenche pas 
un réflexe gonflant, et des erreurs de jugement, de confusion ou 
d'inconscience peuvent se produire en quelques secondes et sans 
avertissement. 

The spectrometer has a connector that enables the sample compartment to be purged using 
clean, dry, oil-free air or nitrogen. The recommended flow rate is 4 L/min. It also has two 
connectors that enable the instrument body to be purged. The recommended flow rate is 
2 L/min.  

The sample compartment purge vents to its surroundings. The instrument purge outlet can 
be connected with tubing to vent outside the working environment, for example to a fume 
cabinet. 

Use of flammable solvents and samples 
 

 
WARNING 

 

AVERTISSEMENT 

The instrument contains a hot source, and contact with flammable 
vapors may cause an explosion. Flammable solvents or samples should 
not be stored on or near the instrument. During sample preparation, 
such materials should be handled in a safe area away from the 
instrument, such as a fume cabinet. 

L'instrument contient une source d'énergie chaude, et le contact avec 
des vapeurs inflammables peut provoquer une explosion. Les solvants 
ou échantillons inflammables ne doivent pas être stockés sur ou près 
de l'instrument. Pendant la préparation de l'échantillon, ces matériaux 
doivent être manipulés dans un endroit sûr à l'écart de l'instrument, 
comme une armoire à fumée. 
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Warning Signs on the Instrument 
 

 
 

Warning. 

Refer to accompanying documents in all cases where this symbol is used 
to find out the nature of the potential hazard and any actions which have 
to be taken. 

Avertissement. 

Reportez-vous aux documents d'accompagnement dans tous les cas où 
ce symbole est utilisé pour connaître la nature du danger potentiel et les 
actions à prendre. 

A warning label is attached to the source compartment (Figure 1). Refer to Replacing the 
Source on page 107. 

 

 

Figure 1 Labels (rear of instrument) 

A warning label is attached to the desiccant compartment and near the instrument purge 
inlet port (Figure 2). Refer to Changing the Desiccant on page 98 or to Purging the 
instrument on page 103, as applicable. 

 

Figure 2 Labels (base of instrument) 
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EMC Compliance 

Europe 

All information concerning EMC standards is in the Declaration of Conformity, and these 
standards may change as the European Union adds new requirements.  

PerkinElmer instruments have been designed and manufactured, having regard to the state 
of the art, to ensure that: 

• the electromagnetic disturbance generated does not exceed the level above which 
radio and telecommunications equipment or other equipment cannot operate as 
intended; 

• it has a level of immunity to the electromagnetic disturbance to be expected in its 
intended use which allows it to operate without unacceptable degradation of its 
intended use. 

South Korea 

This device complies with MSIP (Ministry 0f Science, ICT, and Future Planning) EMC 
Registration requirements. This instrument is registered as a Class A instrument for buiness 
use only. Product seller and user should notice that this equipment is not for house hold use. 

A급 기기 (업무용 방송통신기자재) 
이 기기는 업무용(A급) 전자파적합기기로서 판 
매자 또는 사용자는 이 점을 주의하시기 바라 
며, 가정외의 지역에서 사용하는 것을 목적으 
로 합니다. 

United States (FCC) 

United States (FCC) This equipment has been tested and found to comply with the limits for 
a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is operated 
in a commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, 
may cause harmful interference to radio communications. Operation of this equipment in a 
business/industrial/commercial environment is likely to cause harmful interference in which 
the user will be required to correct the interference at your own expense. Changes or 
modifications not expressly approved by the manufacturer could void your authority to 
operate the equipment in compliance with FCC rules. 

Note: Changes or modifications not expressly approved by PerkinElmer could cause the instrument 
to violate FCC (U.S. Federal Communications Commission) emission regulations, and because 
of this violation could void the user’s authority to operate this equipment. 
 



An Overview of the 
Spectrum Two N 
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A Guided Tour of the Spectrum Two N 

PerkinElmer Spectrum Two N spectrometers are compact, robust instruments that can be 
used in non-laboratory environments.  

 

Figure 3 Spectrum Two N Spectrometer 

• Spectrum Two N FT-NIR spectrometers with standard detector: 

– Standard, high-performance, room-temperature LiTaO3 (lithium tantalate) NIR 
detector. 

– Optical system with CaF2 windows enables you to collect data over a total range 
of 14,700 to 2,000 cm−1 at a best resolution of 1.0 cm−1 at 7,200 cm-1. 

– Standard APV/AVI configuration.  

For APV, an internal, software-controlled filter wheel comes complete with traceable 
reference materials for automatic performance verification. Also, the methane cell 
provided enables the production of standard data to be referenced to fundamental 
band positions using the Absolute Virtual Instrument (AVI) feature. 

• Spectrum Two FT-IR spectrometers with temperature-stabilized detector: 

– Temperature-stabilized, high-performance, InGaAs (indium gallium arsenide) NIR 
detector for enhanced signal-to-noise. 

– Optical system enables you to collect data over a total range of 14,700 to 
3,800 cm−1 at a best resolution of 1.0 cm−1 at 7,200 cm-1 with CaF2 windows. 

– Standard APV/AVI configuration.  

For APV, an internal, software-controlled filter wheel comes complete with traceable 
reference materials for automatic performance verification. Also, the methane cell 
provided enables the production of standard data to be referenced to fundamental 
band positions using the Absolute Virtual Instrument (AVI) feature. 

The instrument is connected to a PC, either point-to-point (USB 2.0 or Ethernet), over a 
network, or via a wireless network using the optional wireless router.  

The Spectrum software supplied enables you to control the instrument and to manipulate the 
spectra that you collect. The spectrometers can operate in ratio, single-beam, or 
interferogram mode. 
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Optical system 

The optical system is under the main cover of the instrument. The instrument is sealed at the 
factory, and the main cover of the instrument should not be opened.  

No panel of the spectrometer should be removed unless following the maintenance 
procedures described in this manual. In particular, maintenance procedures that risk ingress 
of water vapor into the instrument should be performed only using the appropriate 
maintenance wizard in Spectrum, Spectrum ES or AssureID Software. See Maintenance on 
page 95 for more information.  

Stability of the optical system 

The system is purged and sealed at the factory. A supply of desiccant placed within the 
system removes any water vapor and carbon dioxide that may enter. The unique humidity 
shield design (part of the OpticsGuard™ system) protects the spectrometer from 
environmental conditions, meaning it can be used in more challenging environments. In 
addition, the internal humidity sensor, in conjunction with the Humidity Shield feature in 
Spectrum software, warns you when the desiccant needs changing. Refer to Humidity Shield 
on page 82 for further information. 

In the Spectrum Two N FT-IR spectrometer, CaF2 windows separate the sample 
compartment from the purged optical system.  

You can purge the sample compartment with clean, dry, oil-free air or nitrogen. Either one 
removes water vapor; however, nitrogen is preferable because it also removes atmospheric 
carbon dioxide. 

Sample compartment 

The instrument has a versatile, purgeable sample compartment (Figure 4) located at the 
front of the instrument. Open the sample compartment by lifting the cover using the recess 
at the front. 

 

Figure 4 Sample compartment 

Sample compartment lid 

Slide holder 
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The infrared beam enters the sample compartment through a window on the left. After 
passing through the sample, it enters the detector area through a window on the right side 
of the sample compartment. 
 

CAUTION 

 

 
ATTENTION 

The CaF2 sample compartment windows fitted in some Spectrum Two N 
FT-NIR spectrometers, although coated to prevent damage by small 
amounts of condensation, may be damaged by large amounts of 
condensation build-up in the rim of the windows. 

Take care not to scratch the windows when installing accessories or using 
sample tools. 

Les fenêtres du compartiment d'échantillons CaF2 installées dans certains 
spectromètres Spectrum Two N FT NIR, bien que revêtues pour éviter 
d'être endommagées par de petites quantités de condensation, peuvent 
être endommagées par de grandes quantités d'accumulation de 
condensation dans la jante des fenêtres. 

Veillez à ne pas gratter les fenêtres lors de l'installation d'accessoires ou à 
l'aide d'outils d'échantillonnage. 
 

Standard accessories are mounted on a baseplate. The standard baseplate has a slide holder 
that can be fitted at two positions, fixed by a single screw (Figure 5).  

 

Figure 5 Slide holder on standard baseplate  

The slide holder has two slide positions that enable you to insert a sample and a J-stop card 
for measurements at high resolutions. 

For more information on using the J-stop cards, see Changing the Resolution on page 78. 
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Power switch and communication ports 

The DC power connector and communication ports are on the rear of the instrument.  

The Power on LED on the front of the instrument will light green when the instrument is 
connected to mains power and is switched on (Figure 6). 

 

Figure 6 Power ON LED 

NOTE: The Spectrum Two N spectrometer is usable within 15 minutes of being switched on 
after being switched off overnight. However, if your instrument has recently been 
transferred from a much colder environment, it is advisable to run a background 
spectrum before every sample for the first couple of hours of use. 

Portability 

The compact and robust design of the Spectrum Two N means that the instrument can be 
easily transferred between environments. The simple user-installation, and fast warm-up 
time, means that the instrument can be set up quickly. The range of accessories available 
help you to move your analysis out of the laboratory. Optional wireless connectivity enables 
portable PC control, and the multiple power options enable you to use your spectrometer 
with, or without, external mains power (Figure 7). 

 

 

Figure 7 Spectrum Two N with wireless router and battery pack 

NOTE: The battery pack can also be used as an uninterruptable power supply (UPS). 

The Portability Pack includes a battery pack and 12 V car auxiliary port adaptor, spectrometer 
carry case and a wireless router kit. The individual components of the Portability Pack are 
also available separately. Refer to Optional parts on page 114. 

Power ON 
LED 



24 . Spectrum Two N User's Guide 

Accessories 

There is a range of optional sampling accessories available for the Spectrum Two N FT-NIR 
spectrometer that fit in the sample compartment, including: 

• Spectrum Two N NIRM – Near Infrared Reflectance Module – L1390205 
The Near Infrared Reflectance Module (NIRM) has a patented collection optics system 
designed for robust, accurate operation, offering increased performance with dramatically 
improved inter-unit variability. The design is less sensitive than conventional designs to 
sample height and tilt. It is designed with built-in automatic fast interleaved scanning 
which alleviates drift and improves measurement time. The NIRM contains a high 
performance stabilized InGaAs detector system as standard. (Figure 8). 
Refer to the NIRM User’s Guide (part number L1050301) available as a pdf on the 
Spectrum Two Manuals CD (part number L1050242) for information on using the 
accessory. 

 

Figure 8 Spectrum Two N FT-NIR with the NIRM Accessory 

• Spectrum Two N HTM– Heatable Transmission Module – L1390029 
The Heatable Transmission Module (HTM) for the Spectrum Two N™ NIR allows for 
easy elevated temperature measurements on samples in the mid-IR or Near-IR regions 
of the spectrum, the module accepts fixed pathlength sealed cells, cuvettes, or 
disposable vials.. 
Refer to the Heatable Transmission Module (HTM) User’s Guide (part number L1050302) 
available as a pdf on the Spectrum Two Manuals CD (part number L1050242) for 
information on using the accessory. 

• Spectrum Two N RSM – Remote Sampling Module – L1390040  
Spectrum Two N sample compartment interface fitted with universal connectors for 
compatibility with a wide range of fiber probes. Includes built high performance InGaAs 
detector. 
Refer to the Remote Sampling Module (RSM) User’s Guide (part number L1050303) 
available as a pdf on the Spectrum Two Manuals CD (part number L1050242) for 
information on using the accessory. 

It is easy to remove an accessory and replace it with another. Refer to Changing the 
Sampling Accessory on page 43. For the baseplate-mounted accessories, a coded connector 
on the baseplate plugs into a socket on the rear wall of the sample compartment. The 
instrument identifies the type of accessory and automatically updates the instrument 
settings.  
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Requirements 

NOTE: Read the warnings and safety information chapter in this manual before you install 
the instrument. It contains important information. 

Electrical requirements 

The Spectrum Two N power supply adaptor can operate on electricity supplies of 50 or 60 Hz 
and in the 100 to 230 V range without any adjustment.  

The maximum power consumption of the system is 65 VA (approximately 40 W) when 
powering the wireless router. In Power Save mode the mains power consumption is <10 VA 
(approximately 6 W) and the DC power consumption is 0.2 W. 

The line supply must be within 10% of the nominal voltage. 

If possible, do not connect the instrument to circuits that have heavy-duty equipment 
connected, such as large motors. 

If possible, do not use photocopiers, discharge lamps, radio transmitters, and other 
equipment with large or frequent transient loads on the same supply circuit. 

Environment 

To obtain the best performance from your instrument: 

• Place the instrument in an environment that is relatively dry and dust-free. 

• Make sure that the bench top is free from vibration or mechanical shocks. 

• Do not place the instrument or the PC near to room-heating equipment, such as  
central-heating radiators. 

• Do not position the instrument in direct sunlight as this may cause overheating. 

• Ensure that there is sufficient clearance underneath the instrument to permit an 
adequate flow of cooling air. 

• The area near the PC must be free of strong magnetic fields, direct sunlight, and 
heating or cooling units or ducts. 
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Specifications  

Specification Value 

Dimensions 450 × 300 × 210 mm (W × D × H ) 

Weight Approximately 13 kg 

Power input 100–230 V, 50/60 Hz, Max 65 VA 

Laser Class 1 

Detector LiTaO3 or InGaAs 

Operating temperature range 5 °C to 45 °C* 

Storage temperature range −20 °C to 60 °C 

Maximum relative humidity 80% (non-condensing) with CaF2 windows 

 
* If you intend to operate your instrument regularly at temperatures of 40 °C or higher, for optimum 
performance we recommend that you repeat the Wavelength Calibration at the appropriate operating 
temperature. Refer to the on-screen help for your software application. 
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Unpacking the Spectrometer 

CAUTION 

ATTENTION 

Take great care when installing your Spectrum Two N FT-NIR 
spectrometer, and follow the procedures described in this manual. If you 
require further assistance, please contact 
IRTechSupport@PERKINELMER.COM. 

Faites attention lors de l'installation de votre spectromètre Spectrum Two 
N FT NIR et suivez les procédures décrites dans ce manuel. Si vous avez 
besoin d'aide supplémentaire, contactez 
IRTechSupport@PERKINELMER.COM. 

Opening the shipping container 

Your spectrometer is packed inside the shipping container, sealed inside a silver bag that 
protects the windows from condensation.  

1. Remove the items from the box, and check that all the following parts are present: 
 

Part Number Description Quantity 

L9004169 USB 2.0 Cable (2 m) 1 

L9002298 Power supply 1 

L1180478 NIR Polystyrene TRM Kit  1 

L1600232  Spectrum Two J-stop card kit containing: 
0.5 cm−1, 1 cm−1, 2 cm−1, and 4 cm−1 J-stop cards 

1 

LX108873 

OR 

LX108941 

OR 

LX108875 

Spectrum Standard Software (DVD) 

 

Spectrum Standard Software (USB Flash Drive) 

 

Spectrum ES Software (DVD) 

1 

L1050280 Spectrum Two Installation Video CD 1 

L1050229 Spectrum Two Installation Guide (USB connection) 1 

L1050242 Spectrum Two Manuals CD 1 

 
If any items are missing or damaged, contact IRTechSupport@PERKINELMER.COM for 
assistance. 

mailto:IRTechSupport@PERKINELMER.COM
mailto:IRTechSupport@PERKINELMER.COM
mailto:IRTechSupport@PERKINELMER.COM
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2. Carefully remove the instrument from the shipping container, but not from the bag in 
which it was shipped. 
Retain the original packaging in case you need to ship the instrument to a new location.  
 

CAUTION 

 
ATTENTION 

The spectrometer should be allowed to reach the temperature of its 
surroundings before it is removed from the protective bag to prevent 
condensation forming on the CaF2 windows. This means leaving it for at 
least 3 hours after removal from the shipping container. 

Le spectromètre doit être autorisé à atteindre la température de son 
environnement avant d'être retiré du sac de protection afin d'empêcher 
la formation de condensation sur les fenêtres CaF2. Cela signifie le laisser 
pendant au moins 3 heures après le retrait du conteneur d'expédition. 
 

3. When the spectrometer has been allowed to warm to the temperature of its 
surroundings, remove it from the bag and place it on the bench where it is to be used. 
Ensure that you can reach the rear of the spectrometer to enable you to connect the 
cables. 

NOTE: Do not connect your instrument to the PC using the USB cable provided until you 
have run the software installation wizard. 

Any accessories will be shipped in separate boxes. 
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Choosing Your Connection Method 

NOTE: Do not connect your instrument to the PC using the USB cable provided until you 
have run the software installation wizard. 

The Spectrum Two N spectrometer is supplied with a USB 2.0 cable and a mains power 
supply adaptor with a DC connector (Figure 9). The mains power cord supplied will depend 
on your region. 

 

Figure 9 Connection cables supplied with the Spectrum Two  

There are four ways you can connect to your spectrometer: 

• Using the supplied USB 2.0 cable to connect directly to the PC. 
This is the preferred method for direct connection to the spectrometer. The instrument 
will be configured automatically when you start Spectrum software. 

• Using an Ethernet cable (not supplied) to connect directly to the PC. 
If you want to connect your instrument directly to the PC using the Ethernet port, refer 
to the Administrator’s Guide for your software for information on configuring the PC 
network adaptor. We recommend that you do this before installing Spectrum, 
Spectrum ES, or AssureID software. 

• Over a wireless network using the PerkinElmer-configured wireless router (part number 
L1600246, not supplied with the spectrometer). 
The optional wireless router enables you to locate your spectrometer away from the PC. 
This facilitates use of the spectrometer inside a fume cabinet or in a manufacturing 
environment. 
Once you are connected to the instrument using the PerkinElmer FT-IR Wireless 
network, the instrument will automatically be configured on starting Spectrum software. 

• Over a network using the Ethernet port. 
If you want to connect your instrument over a network using the Ethernet port, refer to 
the Administrator’s Guide for your software for information on configuring the IP 
address of your instrument, and details of the Instrument Install Wizard. 

Spectrometer 
connector 

PC connector 

Mains power 
cord connector 

DC power 
connector 

Mains power 
adaptor 

USB 2.0 cable 
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The features on the rear of the spectrometer are shown in Figure 10.  

 

Figure 10 Communication ports on the Spectrum Two 

Table 1 Communication ports 

 Port/LED Use 

A USB port 

 

This is the standard interface between the PC and the 
instrument. 

B ETHERNET port 

 

Ethernet connector.  

This is the standard interface between a Local Area Network 
(LAN) and the instrument.  

C EXT DETECTOR 

port 

This port enables to you power the optional wireless router, 
accessory alignment tool, or connect an external accessory. 

D Rear diagnostic 
LED 

Provides information on the status of the instrument. 

Refer to Table 2 on page 34. 

E DC power port The DC power port is used to connect the spectrometer to 
the power supply. You can use the mains power supply 
adaptor and cable supplied, or you can use the optional 
battery pack or car adaptor. 

NOTE: For more details of the port connector types, refer to Appendix 1: Connector Details 
on page 118. 

A C B E D 
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Installing your Spectrum Two N 

NOTE: Do not connect your instrument to the PC using the USB cable provided until you 
have run the software installation wizard. 

 

NOTE: If you wish to connect to your instrument using an Ethernet cable, you will need to 
configure the PC network adaptor. We recommend that you do this before installing 
your software. 

 To install your software package (Spectrum, Spectrum ES, or AssureID, as required), 
insert the supplied DVD or USB Flash Drive and follow the instructions on the screen.  
You will need to select Spectrum Two as the Installation Type in Spectrum and 
Spectrum ES software. 
If required, full installation instructions are provided in the Administrator’s Guide for 
your software, which can be found on the Spectrum Two Manuals CD supplied with your 
instrument. 
If you are supplying your own computer, make sure that it meets the minimum 
requirements for hardware and software set out in the “PC Requirements” section of the 
Administrator’s Guide. 

Spectrum and Spectrum ES software applications are available in German, English, Spanish, 
French, Japanese, Brazilian Portuguese and Simplified Chinese. The software language 
displayed is determined by the Region and Language settings defined for the operating 
system on the PC. 

During the Spectrum software installation you will be provided with USB and wireless 
connection instructions (Figure 11). Connect your instrument to the mains power, and then 
set up your USB or wireless connection. For other connection methods, you do not need to 
connect up your instrument at this point. Refer to Connecting the spectrometer to the PC 
using the USB cable on page 34 or Connecting the spectrometer to the PC using the wireless 
router on page 36, as applicable.  

 

Figure 11 USB and Wireless Connection Instructions dialog 
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Connecting the spectrometer to the electrical supply 

The Spectrum Two N power supply adaptor can operate on electricity supplies of 50 or 60 Hz 
and in the 100 to 230 V range without any adjustment. The mains power cord supplied will 
depend on the requirements of your region.  

NOTE: If it is necessary to fit a different plug on the power cord to the one supplied, refer to 
Electrical safety starting on page 14. 

1. Ensure that your instrument is located near an appropriate mains power outlet.  

2. Connect the cable from the power supply adaptor to the 18 V DC port on the rear of the 
instrument (Figure 12). 

 

Figure 12 Power adaptor port on rear of the instrument 

3. Connect the region-specific mains power cable provided to the power supply adaptor, 
and connect it to the mains power supply. 

4. Switch on the power at the mains supply. 
The instrument will power up automatically. The Power ON LED on the front of the 
instrument will be lit green (Figure 13). 

 

Figure 13 Power ON LED 

Your instrument will initialize and will then be ready to communicate with the PC. This will 
take approximately 2 minutes. During the initialization procedure the diagnostic LED on the 
rear of the instrument appears yellow as the instrument runs a series of self-checks. At the 
end of the initialization period, the diagnostic LED will flash orange. 

Power adaptor 
connector 

Diagnostic 
LED 

18 V DC power 
adaptor port  

Power ON 
LED 



34 . Spectrum Two N User's Guide 

Table 2 LED status 

LED Appearance Status 

Power ON 
(front of 
instrument) 

Green, solid Instrument is on. 

Yellow, flashing Instrument is in Power Save mode (software controlled). 

Yellow, solid Instrument is in Power Save mode (not software 
controlled). 

Off Instrument is off. 

Check that the instrument is connected to the mains 
power.  

Diagnostic 
(rear of 
instrument) 

Yellow, solid Instrument is running self-checks on initialization. 

Orange, flashing Instrument is connected to mains power and is initialized. 

Red, flashing Instrument has failed self-checks on initialization. You will 
not be able to connect to the instrument in the software. 

Refer to IRTechSupport@PERKINELMER.COM for assistance.  

Off Instrument is off. 

Check that the instrument is connected to the mains 
power.  

Before connecting your spectrometer to the PC you must install Spectrum, Spectrum ES or 
AssureID software. 

NOTE: Once your instrument has been set up in one software application it will be available 
for use by all PerkinElmer FT-IR software installed on the PC. 

Connecting the spectrometer to the PC using the USB 
cable 

Before connecting your spectrometer to the PC via the USB cable you must run the Spectrum 
or Spectrum ES software installation. This is so that the appropriate drivers for the USB port 
are installed. 

For Spectrum and Spectrum ES software, only connect the USB cable when prompted by the 
software Installation Wizard. 

If you are using AssureID as stand-alone software, and have not previously installed 
Spectrum with Spectrum Two Installation Type, you will need to install the drivers for the 
USB connection. Refer to the AssureID Administrator’s Guide (part number L1050019) for 
more information. 
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The following procedure describes connection using the USB 2.0 cable supplied with your 
instrument for Spectrum or Spectrum ES software: 

1. When prompted by the Spectrum software installer, plug one end of the USB 2.0 cable 
provided into the USB port on the rear of the instrument (Figure 14). 

 

Figure 14 USB 2.0 cable connector and USB port  

2. Plug the other end of the cable into a USB 2.0 port on your PC. 

3. Click Test USB on the USB and Wireless Connection Instructions dialog. 
The software checks that the USB drivers have installed correctly and the result is 
displayed (Figure 15). 

 

Figure 15 USB Wireless Connection Instructions – successful 

If the test fails, check that the instrument is connected to the mains power and is 
connected to the PC using the USB 2.0 cable provided, and then retry the test.  
If the test still fails, go to IRTechSupport@PERKINELMER.COM for assistance.   

USB port 

 

USB 2.0 cable spectrometer 
connection 
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4. Continue the Spectrum software installation, following the instructions displayed  
on-screen. 

You are now ready to start Spectrum software. The first time you log on to Spectrum with a 
Spectrum Two instrument connected to the PC via a USB cable, the instrument is installed 
and configured automatically. 

NOTE: For AssureID, install the USB drivers, connect your spectrometer as shown in 
Figure 14, start AssureID, and then run the Instrument Install Wizard (see page 42). 
Refer to the AssureID Administrator’s Guide (part number L1050019) for more 
information. 

Connecting the spectrometer to the PC using the 
wireless router  

The following procedure describes connection using the PerkinElmer-configured wireless 
router (not supplied with the instrument). The wireless router is powered by the EXT 
DETECTOR port on the rear of the Spectrum Two N instrument. The cable required is 
supplied with the wireless router. 

NOTE: If you are powering your instrument using the optional Spectrum Two N Battery Pack 
(part number L1600233), powering the wireless router will reduce the runtime of the 
battery. 

1. Unpack your wireless router, and position it near the instrument. 

2. Connect the wireless router to the EXT DETECTOR port at the rear of the spectrometer 
using the cable supplied (part number L1602706), as shown in Figure 16. 

 

Figure 16 Wireless router connected to the EXT DETECTOR port  

EXT DETECTOR port 

POWER port 

http://lassgna10/pdm/parts/Official_Specification.aspx?Type=Part&Part=L1602706&Rev=02
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3. Connect one end of the Ethernet cable to the ETHERNET port on the rear of the 
spectrometer and the other end to one of the ports numbered 1 to 4 on the rear of the 
router (Figure 17). 
Do not use the blue port labeled INTERNET on the wireless router. 

 

Figure 17 Ethernet cable connected to Port 4 on the wireless router and the 
Spectrum Two 

4. Connect the cable from the power supply adaptor to the 18 V DC port on the rear of the 
instrument (Figure 18). 

 

Figure 18 Power adaptor port on rear of spectrometer 

5. Connect the Spectrum Two N power supply cable to the mains power. 

6. Ensure that the Power ON LED on the front of the Spectrum Two N is lit green. 
For more information on powering up your spectrometer, refer to Connecting the 
spectrometer to the electrical supply on page 33. 

Port 4 

ETHERNET port 

Power adaptor 
connector 

Diagnostic 
LED 

18 V DC power 
adaptor port  
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7. Ensure that the POWER LED on the front of the wireless router is lit green (Figure 19). 
The POWER LED will flash while the router initializes.  

 

Figure 19 POWER LED on the wireless router 

8. Wait for the POWER LED on the router to stop flashing and ensure that the WIRELESS 
LED is lit (Figure 20). 

 

Figure 20 Wireless router LEDs indicate ready for use 

9. Switch on your PC and then connect to the PerkinElmer FT-IR Wireless network. 
You will need to enter the network security key provided on the side of your router. 

 

Figure 21 Connecting to the PerkinElmer FT-IR Wireless network (example only) 

The exact procedure for connecting your PC to the wireless network will depend on your 
wireless hardware and on the PC operating system. 

WIRELESS LED lit 

POWER LED not 
flashing 

POWER LED lit 
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You are now ready to start your software application. The first time you log on to Spectrum 
with a Spectrum Two N instrument connected to the PC via a wireless connection, the 
instrument is installed and configured automatically for you.  

NOTE: For AssureID, connect your spectrometer as described in steps 1–9, start AssureID, 
and then run the Instrument Install Wizard (see page 42). Refer to the AssureID 
Administrator’s Guide (part number L1050019) for more information. 

 

NOTE: Although you can have more than one instrument on the wireless network, providing 
that each instrument has a unique IP address, you can only connect to one 
spectrometer at a time. PerkinElmer FT-IR software does not support simultaneous 
connection to multiple instruments on the same PC. 

Connecting the spectrometer to the PC using an 
Ethernet cable 

If you want to connect directly to your spectrometer via an Ethernet cable (not supplied), 
you must: 

1. Configure the PC network adaptor to communicate with your spectrometer. 
To connect to your instrument using an Ethernet port you will need to set up the TCP/IP 
protocols on the PC to be compatible with the spectrometer. You must do this before 
you start your software with your instrument connected to the PC.  
If your PC is not on a network, you should type 167 . 116 . 185 . 70 as the IP address 
and type 255 . 255 . 0 . 0 as the subnet mask.  

 
Refer to the Administrator’s Guide for your software for a full procedure. 
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2. Plug one end of an Ethernet cable into the ETHERNET port on the rear of the 
instrument (Figure 22). 

 

Figure 22 Ethernet cable connected to the ETHERNET port  

3. Plug the other end of the cable into an Ethernet port on your PC. 

You are now ready to start Spectrum software. The first time you log on to Spectrum with a 
Spectrum Two N instrument connected to the PC using an Ethernet cable, the instrument is 
installed and configured automatically for you.  

NOTE: For AssureID, configure the PC network adaptor, connect your spectrometer as 
shown in Figure 22, start AssureID, and then run the Instrument Install Wizard (see 
page 42). Refer to the AssureID Administrator’s Guide (part number L1050019) for 
more information. 

Connecting the spectrometer via a network  

If you want to install your spectrometer using an Ethernet connection over a network you 
must: 

1. Assign the instrument a unique IP address that is compatible with your network using 
the Set IP Address Utility. 
To run the utiliity, double-click Set IP Address, which is found in C:\Program Files\ 
PerkinElmer\ServiceIR or C:\Program Files (x86)\PerkinElmer\ServiceIR.  

NOTE: The TCP/IP address of the PC must be compatible with the instrument’s IP address 
so that you can connect to the instrument using the Set IP Address utility. Refer to 
Connecting the spectrometer to the PC using an Ethernet cable above.  

Select your instrument from the drop-down list. The default IP address of the 
instrument is 167 . 116 . 185 . 71. 
You can then assign a new IP address for the instrument.  

Ethernet port 

Ethernet cable 
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When using a network, the TCP/IP port of the PC will normally obtain an automatic 
address from a DHCP server. To communicate with the instrument over a network, the 
instrument must have a compatible network address.  
A subnet mask of 255 . 255 . 0 . 0 means that the first two parts of the instrument IP 
address must match the network IP address given to the PC by the DHCP server. 
If, for example, the IP address of your PC is 195 . 112 . 170 . 255 and the subnet mask 
is 255 . 255 . 0 . 0, then your instrument IP address must be 195 . 112 . x . x. 
Refer to the Administrator’s Guide for your software for a full procedure. 

2. Plug one end of an Ethernet cable into the ETHERNET port on the rear of the 
instrument (Figure 23). 

 

Figure 23 Ethernet cable connected to the ETHERNET port  

3. Connect the other end of the Ethernet cable to the network router. 

4. Add the instrument to the software using the Instrument Install Wizard, entering 
the IP address of the instrument when prompted. 

Ethernet 
port 

Ethernet cable 
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Instrument Install Wizard 

If you connected your spectrometer to a network using the Ethernet connection, or if you are 
using AssureID software to connect to the spectrometer, you will need to run the Instrument 
Install Wizard.  

 If you have AssureID software, select Configure Instruments from the Configure 
Instruments and Accessories group on the Tools menu. 
The Instrument Install Wizard starts. 

OR 

If you have Spectrum or Spectrum ES software, select Add Instrument from the 
Instruments group on the Setup menu. 
The Instrument Install Wizard starts. 
Details of the Instrument Install Wizard can be found in the Administrator’s Guide for 
your software, which can be found on the Spectrum Two Manuals CD. 
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Changing the Sampling Accessory 

NOTE: For full installation and usage instructions for your accessory, refer to the appropriate 
User’s Guide available as a pdf on the Spectrum Two Manuals CD (part number 
L1050242). 

1. If you are installing a NIRM, you will need to remove the sample compartment cover 
(Figure 24), if fitted. 
Open the cover, raise it to the vertical position and then lift it upwards, clear of the 
instrument. 
Store the cover in a safe place for future re-use. 

 

Figure 24 Removing the sample compartment cover 

2. Remove the current sampling accessory by pulling the baseplate of the accessory 
towards you (Figure 25). 

 

Figure 25 Removing the sampling accessory 

Sample 
compartment 
cover 

Slide holder on  
baseplate 
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3. If you are installing a NIRM, pivot the accessory on the ledge at the front of the sample 
area), and then tip it backwards). Push it firmly, ensuring that the top of the accessory 
connects properly with the lid of the instrument. 
If the accessory is pivoted too far forward on the sample area ledge it will not move 
correctly into position. 

OR 

For other baseplate-mounted accessories, drop the accessory baseplate gently onto the 
ledge (Figure 26) and then slide it horizontally into the sample compartment. 
Push the accessory firmly to ensure that the connector on the rear of the baseplate 
engages properly with the spectrometer connector. 

 

Figure 26 Installing the sampling accessory 

Slide accessory 
into connector 
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Spectrum automatically recognizes which accessory is installed, and displays the accessory 
information on the Setup Instrument tabs.  

 

Figure 27 Setup Instrument Basic tab showing a NIRM 

For information on using your accessory, refer to the User’s Guide supplied with your 
accessory. For PerkinElmer Spectrum Two accessories, these can be found as pdf files on the 
Spectrum Two Manuals CD (part number L1050242). 
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Moving the Spectrometer 
 

 
WARNING 

AVERTISSEMENT 

Before moving the spectrometer, switch off the power supply, and 
disconnect the power cable. 

Avant de déplacer le spectromètre, éteignez l'alimentation et 
débranchez le câble d'alimentation. 

The spectrometer can be lifted using the shaped handholds on its sides, as shown in 
Figure 28.  

 

Figure 28 Lifting the Spectrum Two N 

For transportation between a car or laboratory, or between laboratories within your 
establishment, we recommend that you use the Spectrum Two Carry Case (part number 
L9004199).  

If you need to ship your spectrometer, or return it to PerkinElmer following instrument 
replacement, you should use the original packaging.  

NOTE: Refer to Appendix 3: Decontamination and Cleaning on page 120 for more 
information. 

Although the Spectrum Two N spectrometer is usable within 15 minutes of being switched on 
after being switched off overnight, if your instrument has recently been transferred from a 
much colder environment it is advisable to run a background spectrum before every sample 
for the first couple of hours of use. 

 



Getting Started with 
Spectrum Software 
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Overview 

This section describes some of the basic functionality available in Spectrum software. It will 
guide you through the process, from when you start Spectrum software to when you export 
your data, directing you to additional information where applicable.  

It will show you how you can: 

• Log in to Spectrum software 

• Familiarize yourself with the Spectrum customizable workspace and the additional user 
assistance that is available: on-screen Help and Tutorials 

• Check that the components of your spectrometer are working 

• Collect a simple sample measurement 

• Check/improve the quality of your spectrum 

• Process your data in Spectrum software 

• Extract your data from Spectrum software 

• Change some advanced instrument settings 

• Save energy with the Power Save mode 

• Determine if your system is working as expected 

• Exit Spectrum software, retaining your current work if required. 
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Starting Spectrum Software 

1. Ensure that the instrument is connected to the mains power. 
The Power LED on the front of the instrument should be lit green. If it is yellow, and 
you wish to connect to the instrument straight away hold down the power button on the 
front of the spectrometer for two seconds until the LED is lit green. 
The instrument will initialize, which will take approximately 2 minutes. 

NOTE: The Spectrum Two N spectrometer is usable within 15 minutes of being switched on 
after being switched off overnight. However, if your instrument has recently been 
transferred from a much colder environment, it is advisable to run a background 
spectrum before every sample for the first couple of hours of use. 

2. From the Start menu select Programs; the PerkinElmer Applications group; the 
Spectrum sub-group and then the Spectrum application. 

OR 

Double-click the shortcut icon  on the desktop. 
The Spectrum start-up splash-screen is displayed, followed by a dialog that may require 
your login details: 

 

3. If required, enter your User name and Password, and then click OK. 
The default user name and password are Administrator and administrator, respectively.  
If you already have an instrument set up in Spectrum or AssureID software for this user 
on this PC, the Instrument Connection dialog may be displayed, unless Auto-Connect is 
set up for the instrument. If Auto-Connect is enabled, Spectrum will automatically 
connect to the instrument. 

 

NOTE: We recommend that you create a new user and password the first time you log on to 
Spectrum. 
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4. Select the Instrument you want to use and then click Connect. 

OR 

If you want to work with data that has been collected previously, without connecting to 
an instrument, select work offline. 
Spectrum starts.  
The first time you connect to your instrument the Component Checks will run.  

 

5. When the Component Checks are complete, if there are no errors click OK.  
You are now ready to collect data.  
If a problem is identified, refer to Component Checks on page 80 for more information. 
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The Spectrum Workspace 
The Spectrum window, with the default layout for a Spectrum Two N installation, is shown in 
Figure 29. 

 

Figure 29 Spectrum window 

A Global Toolbars F Graph Bar 

B Data Explorer G Navigation Pane 

C Viewing Area H Process Bar 

D Information Pane I Status Bar 

E Dialog Pane   

The window is divided into four panes: 

• The Viewing Area (C), in the center, where spectra or results are displayed.  

• The Data Explorer (B), on the left, which you use to manage your spectra. 

• The Navigation Pane (F), on the right, which contains shortcuts. 

• The Dialog Pane (E), at the bottom, which you use to adjust parameters or enter 
information when, for example, setting up your instrument. 

To open or close a pane, click . 

NOTE: You can also click and drag the edge of a pane to resize it. 

Viewing Area 

The Viewing Area (C) is a tabbed display. The tabs displayed depend on whether you have 
an individual spectrum displayed, or whether you have selected a folder of spectra, known as 
a Samples View, in the Data Explorer. Tabs may be added that show the results of some 
processes, such as Compare, Search and Quant. 

During scanning, the Live tab – which shows the spectrum in real time – may be displayed. 
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Data Explorer 

Data Explorer (B), on the left, which you use to manage your spectra. 

The item(s) selected in the Data Explorer will be displayed in the Viewing Area. 

You can also use the Data Explorer to access the Sample Table, which enables you to set up 
multiple samples for data collection.  

Navigation Pane 

The Navigation Pane (F), on the right, which contains shortcuts. 

The Setup options are the same as the Setup menu items. The Equations and Spectral 
Libraries options on the Navigation Pane enable you to see a list of the available equations 
and libraries, respectively. 

You can reorder the shortcuts in the Navigation pane so that those you use most often are 
easier to access. Simply drag-and-drop the shortcut to a new position. 

Dialog Pane 

The Dialog Pane (E), at the bottom, which you use to adjust parameters or enter information 
when, for example, setting up your instrument or a Compare processes. 

The contents of the Dialog Pane reflect the shortcut selected in the Navigation Pane. 

Global Toolbars 

At the top of the workspace are the Global toolbars (A), which include the File bar and the 
Measurement bar (displayed by default), and the optional Instrument Settings bar.  

NOTE: The Spectrum toolbars can be individually customized, and new toolbars can be 
added. For more information, refer to the Spectrum on-screen Help and the tutorial 
Customizing Toolbars. These can be accessed from the Help menu. 

Graph Toolbars 

If the Graph or Samples View tab is displayed, you can see the local Graph toolbars. The 
Graph bar (G) contains some tools that enable you to change how data is displayed in the 
graph, and the Process bar (H) enables you to access shortcuts to processes that enable you 
to manipulate your data.  

NOTE: The Spectrum toolbars can be individually customized, and new toolbars can be 
added. For more information, refer to the Spectrum on-screen Help and the tutorial 
Customizing Toolbars. These can be accessed from the Help menu. 

Information Pane 

Below the graph in the viewing area is the Information Pane (D). This shows a curve selector 
if you have selected a Samples View in the Data Explorer or, if an individual spectrum is 
selected, shows the results for that spectrum. 
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Status Bar 

The Status Bar (I) located at the bottom of the workspace shows user information, 
messages, and the current status of the instrument.  

 

Figure 30 Status bar 



54 . Spectrum Two N User's Guide 

Using the Spectrum on-screen Help system 

Use the Spectrum Help system to find further information about using Spectrum software to 
control, set up and adjust your instrument. 

To open the Help file, select Contents from the Help menu. This menu also includes links to 
on-screen tutorials (Tutorials), and information about the software (About). 

 

Figure 31 Help menu in Spectrum Software 
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Scanning Samples 

When you connect to your Spectrum Two N, the instrument settings will default to 
appropriate values for your instrument and accessory. These should be suitable for most 
applications. The default scan range is 10,000 to 4,000 cm−1.  

The Measurement bar (Figure 32) displayed by default at the top of the workspace includes 
the tools you need to collect a spectrum from a sample. You can also select these commands 
from the Measurement menu. 

 

Figure 32 Spectrum Two Measurement bar 

1. If you want, enter a unique Sample ID and Description for the sample on the 
Instrument Settings toolbar.  
Alternatively you can use the Autoname function to enter a unique Sample ID and 
Description for each scan. The default Sample ID is [User name]_nnn, but you can 
configure this on the Setup Instrument Data Collection tab. For more information, see 
the Spectrum on-screen help. 
If using an NIRM Accessory, ensure that the window is clean before collecting a 
background. 
The background spectrum is displayed briefly, and then the Viewing Area is prepared 
for data collection from your sample. 

2. Place your sample in the instrument and then click . 
By default, during scanning the sample data is displayed on the Live tab in the Viewing 
Area.  
The completed spectrum is displayed on the Graph tab (Figure 33), and added to the 
current Samples View in the Data Explorer. Your spectrum will be saved automatically. 
See Auto-Save Spectra on page 71 for more information. 
The results of the Quality Checks, selected by default on the Setup Instrument 
Advanced tab, are displayed in the results for the spectrum. See Quality Checks on 
page 58 for more information. 

NOTE: If Preview is selected on the Measurement toolbar; the spectrum will be displayed on 
the Live tab in the Viewing Area. This live spectrum will be automatically updated, 
but no data will be collected. This enables you to verify that your sample is suitable 

or, if using a sample accessory. When you are happy with the spectrum, click  to 
begin collecting data. 

If, for any reason, you want to stop scanning your sample, click .  
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Figure 33 Spectrum displayed in the Viewing Area  

If you want to change any of the default instrument settings, select Instrument from the 
Setup menu to display the Setup Instrument tabs. For more information see Instrument 
Settings on page 77. 
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Optical Attenuators for Use with Optional 
InGaAs Detector 

The high detectivity of InGaAs (indium gallium arsenide) detectors makes them prone to 
saturation, a condition that results in non-linear detector responses. Limiting the optical 
throughput to the detector is used to prevent detector saturation and can be accomplished 
through the use of optical attenuators. For spectrometers equipped with the temperature-
stabilized, high-performance InGaAs detector, four optical attenuators are supplied having 
nominal percent transmittance values of 0.5%, 1%, 2%, and 4% T. For information 
regarding calibration of optical attenuator see Appendix 5: Calibration Procedure for Optical 
Attenuators. The 1% beam attenuator is the default attenuator, all final factory tests are 
performed with this attenuator in place. The optical attenuators are inserted into a slot 
located on the detector side sample compartment window, as shown in Figure 34. 

 

Figure 34 Positioning of optical attenuator in sample compartment of Spectrum 
Two N FT-NIR spectrometer. 

In the event of detector saturation a warning message will appear in the Spectrum 10 
software on the bottom right-hand corner as shown in Figure 35. 

 

Figure 35  Warning message displayed in Spectrum 10 software under conditions 
of detector overload 
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Quality Checks 

Quality Checks identify possible problems in the collected spectrum and suggest ways of 
improving the measurement. 

Quality Checks can be selected on the Setup Instrument Advanced tab (Figure 34). Simply 
select the Quality Checks that you want to perform from the list in the Setup Instrument 
Advanced tab and, if required, adjust the threshold Range using the slider bars to suit your 
application.  

To display more information about an individual test, double-click on its name in the list to 
display the Quality Checks Help.  

 

Figure 36 Setup Instrument Advanced tab in Spectrum  

When you collect your spectrum, the selected tests are performed as the data is collected 
and a signal light (green  , amber  , or red  ) indicates the result. 
 

Signal Result Meaning 

 Passed The quality of the spectra is satisfactory. 

 Caution There is a problem that you may want to investigate to improve the 
quality of the spectra you are collecting. 

 Warning There is a serious problem that you should attempt to solve before 
collecting further spectra. 
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The result is displayed in the Results Table, and in the Information Pane for an individual 
spectrum. For example, the Quality Checks reported multiple warnings for the spectrum shown in 
Figure 35. 

 

Figure 37 Quality Checks result shown in the Information Pane 

To see which Quality Checks passed and which identified a problem, select the History tab of the 
spectrum in the Viewing Area and refer to the Quality Checks section of the tab (Figure 36). 

 

Figure 38 History tab showing the results of the individual Quality Checks 

For each check that failed, refer to the Quality Checks Help for suggestions on how to stop it 
occurring again. 
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Processing Spectra 

To process your data in Spectrum software, ensure that the spectra you wish to process are 
selected in the Data Explorer and then select the appropriate option from the Process menu 
(Figure 37). 

 

Figure 39 Process menu in Spectrum 

When the spectra have been processed, if the process generated new spectra they will be 
added to the Data Explorer with _n appended to the name to create a unique Sample ID. 
Spectra created by processing are not saved automatically. For more information, see Saving 
spectra on page 71. 

NOTE: For full details of each process, refer to the Spectrum on-screen Help. 

Spectral correction 

Several processes in Spectrum enable you to adjust your spectra after data collection. For 
example, there are commands for the conversions of ordinate units, such as: Absorbance, 
Transmittance, Kubelka–Munk and Convert X.  
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You can also correct for baseline slope in your spectra. In Spectrum you can do this in two 
ways: using an automatic baseline correction, or using an interactive baseline correction  
(i-baseline) that enables you to define base points for the conversion (Figure 38).  

 

Figure 40 Spectrum with baseline corrected using i-baseline  

NOTE: The Processing Your Data tutorial includes a description of ordinate-unit 
conversion, automatic baseline correction, and peak detection and labeling. 

Identification 

Several processes in Spectrum can be used to help identify your sample. 

Peak Table  

The results of a peak table can be used to compare peaks with another sample – for 
example, one published in a pharmacopoeia. The results of the process are displayed on the 
Peak Table tab in the Viewing Area (Figure 39). 

 

Figure 41 Peak Table tab  

 Select Peak Detection from the Setup menu to display the Setup Peak Detection tab 
and define the thresholds and the algorithm used to identify the peaks. 

NOTE: You can also add peak labels to the spectrum using the same thresholds using the 
Label Peaks option on the View menu. 
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Compare 

The Compare process estimates similarity between spectra by comparison with a reference 
spectrum or spectra, and is used to confirm the identity of a sample. The results are 
displayed on the Compare tab in the Viewing Area (Figure 40). 

 

Figure 42 Compare tab 

In this example, the spectrum has been confirmed to be the same as the reference 
spectrum, where the Correlation was defined at 0.98. The Correlation result is greater than 
0.99, where 1.00 would mean that the spectra were identical. 

NOTE: For an example of a Report generated showing the Compare results, refer to 
Reporting on page 75. 

The parameters used in the Compare process are defined on the Setup Compare tabs. 

 Select Compare from the Setup menu to display the Setup Compare tabs.  

On the Setup Compare References tab (Figure 41) you can load a single spectrum file or a 
folder of spectra. Then set the Correlation and/or Discrimination thresholds to define the 
Pass/Fail result.  

Correlation expresses the degree of similarity between the spectra, where 1 is identical, and 
0 is wholly unrelated. Discrimination ensures that the closest match is sufficiently separated 
from the next closest match. Its value is the difference in the Correlation values of the first 
two results on the Compare tab.  

Only files or folders with Include enabled will be used in the Compare. 

 

Figure 43 Setup Compare References tab 
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On the Setup Compare Parameters tab (Figure 42) you can define a limited wavelength 
range of your spectrum to be compared with the reference spectrum or spectra, and apply 
filters that try to eliminate differences in spectra that are not related to differences in the 
sample, such as differences between instruments or environmental condition. Refer to the 
Spectrum on-screen help for more information. 

 

Figure 44 Setup Compare Parameters tab 

NOTE: The Comparing Spectra tutorial worked example compares the results of a spectra 
subtraction (using the Difference process) to a reference spectrum. 

Search  

The Search process is used to confirm the identity of an unknown sample by comparison with 
a reference library or spectra. The results are displayed on the Search tab in the Viewing 
Area (Figure 43). 

 

Figure 45 Search tab 

In the upper left quadrant the name of your source spectrum or spectra are displayed, with 
the Search Best Hit. In this example the Best Hit was acetophenone. For each source 
spectrum selected, all the results are displayed in the Search Hit list. If you want to select an 
alternative Search Best Hit, you can click Accept as best hit.  

The best hit spectra are displayed in a graph below the Source Spectra Search Results, in the 
lower left quadrant of the Search tab.  

NOTE: You can also use the Search process for a Mixture Search. Refer to the Spectrum  
on-screen help for more information. 
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The parameters used in the Search process are defined on the Setup Libraries and Search 
tabs. 

 Select Search from the Setup menu to display the Setup Libraries and Search tabs.  

Select which folders or files are available as Spectral Libraries on the Setup Spectral Libraries 
tab (Figure 44), and specify which of the available spectral libraries should be included in the 
Search Process. Only files or folders with Include enabled will be used in the Search. 

 

Figure 46 Setup Spectral Libraries tab 

On the Setup Search Parameters tab (Figure 45), enter the maximum number of best hits to 
display in the Search tab when a Search process is run. By default your spectrum is 
compared with each reference spectrum over the range where the spectra overlap. But if you 
are particularly interested in a region select a User defined range, and/or if you want to 
exclude regions from the spectra, enter the appropriate Start and End values in the Blank 
Regions section.  

 

Figure 47 Setup Search Parameters tab 

The Libraries available in Spectrum are listed in the Spectral Libraries section of the 
Navigation Pane. Double-click on the library icon to administer your library (for user-defined 
libraries you can add or remove spectra), or to view information about the library or spectra 
(Figure 46). For example, you can view any properties associated with a particular spectrum 
or the image of a structural unit. 

 

Figure 48 Library details 
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NOTE: The Search tutorial provides an example of using the Search process to identify an 
unknown contaminant in a sample. 

Quantification 

Peak Area/Height 

Use the Peak Area/Height process to produce a table of the peak areas and/or peak heights 
for your spectrum or spectra. You can process spectra individually, or select a spectrum on 
which to define the parameters that will be used for a number of spectra. 

The height can be defined at a point (Height), or as the maximum height between two 
points (Max Height). The Bases section enables you to define the baseline that is used 
when determining the peak area or height. 

 

Figure 49 Peak Area/Height dialog  

When the Peak Area/Height process is run, the results are shown on the Peak Table tab 
(Figure 39). 

Quant 

The Quant process is used to quantify properties of a sample by using one or more Quant 
methods created using the Spectrum Quant Builders. The Spectrum Quant Builder software 
enables you to build a method using a set of standard spectra that you have collected. Once 
the method has been built and then validated in the Quant Builder software, it can be used 
to quantify a component in your sample spectrum.  
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The results are displayed on the Quant tab in the Viewing Area (Figure 48), and in the 
Results table. In this example, the Prediction Property calculated by the Beer’s Law algorithm 
was FAME (fatty acid methyl ester) concentration in % v/v. 

 

Figure 50 Quant tab 

In the upper left quadrant your source spectrum or spectra are displayed, with the Quant 
prediction results. For each source spectrum selected, more information is shown in the 
Details section.  

For each sample, the source spectrum and any spectra generated as part of the analysis are 
displayed in the graph below the Quant results, in the lower left quadrant of the Search tab.  

The Quant methods used in the Quant prediction are defined on the Setup Quant Methods 
tab: 

 Select Quant from the Setup menu to display the Setup Quant tabs.  

Select which Quant methods are available on the Setup Quant Methods tab (Figure 49), and 
specify which of the available methods should be included in the Quant prediction. Only files 
or folders with Include enabled will be used to process the spectra. 

 

Figure 51 Setup Quant Methods tab 
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More information about the method selected is shown in the Quant Method Setup dialog 
(Figure 50): 

 Select Settings on the Setup Quant Methods tab. 
Here you can view a summary of the Quant method and, where the Quant calibration 
includes more than one prediction Property, select which ones will be included when the 
Quant method is run Figure 50).  

 

Figure 52 Quant method details 

On the Setup Report Defaults tab (Figure 51), select which prediction results will be 
displayed for each algorithm type in the Results Table when a Quant prediction is run.  

 

Figure 53 Setup Quant Results tab 

NOTE: Refer to the Spectrum on-screen Help for more information. 
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Equations 

A list of the available Equations is displayed on the Setup Equations tab. The Equations are 
also added to the Equations sub-menu of the Process menu.  

 To add a new Equation, select Equations from the Setup menu to display the Setup 
Equations tab, and then select Add.  
The Equation tab will be displayed (Figure 52).  

 

Figure 54 Equation tab  

You can type in an equation, or click on items in the Operators, Functions or Variables 
lists. Each function has a number of required or optional arguments. A tooltip will be 
displayed when you enter a function to show you the correct syntax. The first argument is 
often <spectrum>, which if set to All will be applied to all spectra selected, but you can 
Browse to select a specific spectrum.  

Any results in the Results table will be available as Variables, as well as the pathlength set 
on the Setup Pathlength tab. In this way you can add numeric custom columns in the Sample 
Table for your spectra and these entries will be available for use in equations. 

When you have finished entering your equation, you can click Check to verify your equation. 

NOTE: The Macros tutorial provides an example of using an Equation to calculate the area 
of a peak. 
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The Results formatting tab enables you to define Pass / Fail criteria and select how the result will 
be displayed. For example, you can color the cell in the Results Table green if the result is a Pass. 

 

Figure 55 Results formatting example 

To view the details of, or modify, an equation: 

 Select Equations in the Navigation Pane and then select the appropriate icon. 

OR 

Select the Equation on the Setup Equations tab, and then click Settings. 

To run the equation, select the spectrum or spectra you want to process in the Data 
Explorer, and then select the equation from the Equations sub-menu of the Process menu.  

Macros 

As well as performing the individual process commands you can combine these to create a 
workflow or Macro. Macros can also include Instrument Setup (Figure 54) and Data 
Collection, and export and reporting commands to enable you to structure your analysis from 
setting the instrument parameters to generating your results.  

 

Figure 56 Macros Settings dialog showing an Instrument Setup step  

NOTE: Refer to the Macros tutorial and the on-screen Help for more information.  
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Scanalyze 

As well as Macros, you can use the Scanalyze feature in Spectrum to scan a spectrum and 
then immediately process it using the Compare, Verify, Quant or Search options. During 
multiple accumulations, the results are displayed and then updated as the data collection 
progresses. 

 

Figure 57 Scanalyze options 

The Compare, Verify, Quant and Search processes must first be set up using the appropriate 
Setup menu option. 

NOTE: You must have a valid background for the Scanalyze option to be available. 
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Saving Spectra, Exporting Spectra and 
Reporting 

There are various features in the software to help you present your data outside Spectrum. 

Saving spectra 

All spectra in Spectrum software are saved to *.sp format by default. 

To find out if a spectrum has been saved, refer to the Results Table (if a Samples View is 
selected) or the Information Pane. Spectra that are not saved are marked by a red cross. 

In Figure 56 the original spectra have been saved to disk, but the processed spectrum, with 
_1 appended, has not. 

 

Figure 58 Saved and unsaved spectra displayed in the Results Table 

You can save your spectra in the following ways: 

• Using the Auto-Save option when collecting spectra 

• Using the Save, Save As and Save All options from the File menu 

• Using an Output step in a Macro 

• Using the context menu in the Viewing Area. 

Auto-Save Spectra 

In Spectrum software, Auto-Save is selected by default (Figure 57). This will save your 
spectra to the folder specified after each measurement. 

 

Figure 59 Auto-Save spectra on the Setup Instrument Data Collection tab 

The default Save Location, here C:\pel_data\spectra, was defined during the software 
installation. If you wish to change the location, or deselect this option, refer to the Setup 
Instrument Data Collection tab. 
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Save, Save As, Save All 

Save will save the selected spectrum, or the spectra in the selected Samples View, to the 
current default save location.  

Save As displays a dialog for the spectra selected that enables you to change the file name 
and the destination directory (Figure 58). You can also change the default save location for 
all spectra.  

 

Figure 60 Save Spectra As dialog 

Save All displays a dialog similar to that shown in Figure 58, but listing all the spectra open 
in Spectrum. 

Save Binary 

Use the Save Binary option in the graph to save the spectrum as a *.sp file. Select a curve 
and then right-click to display a context menu. Select Save Binary, and then browse to a 
save location. 

Exporting spectra 

You can export spectra in several ways: 

• Using the Auto-Save Export option when generating spectra 

• Using the Export option from the File menu 

• Using an Output step in a Macro 

• Using the context menu in the Viewing Area (ASCII format only). 

You can export your spectra to csv format, JCAMP-dx, ASCII, or a custom format. The 
settings for the Custom Defined Format are selected on the Setup Export tab. Refer to the 
Spectrum on-screen Help for more information. 
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Auto-Save Export 

If you select Export on the Setup Instrument Data Collection tab, your spectra will be 
exported to the location specified after each measurement (Figure 59).  

 

Figure 61 Auto-export on the Setup Instrument Data Collection tab 

The default Save Location, here C:\pel_data\spectra, was defined during the software 
installation. To select this option, or to change the default save location, refer to the Setup 
Instrument Data Collection tab. 

Export 

You can export your spectra at any time using the Export option from the File menu. The 
Export Data dialog displayed lists the selected spectrum or the spectra in the selected 
Samples View (Figure 60). You can enter a file name and the destination directory, and then 
choose the file format the spectra will be exported to.  

 

Figure 62 Export dialog 

Save ASC 

Use the Save ASC option in the graph to save the spectrum as an ASCII file (*.asc). Select a 
curve and then right-click to display a context menu. Select Save ASC, and then browse to a 
save location. 
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Send To 

The Send To option (Figure 61) sends the contents of the current window to the selected 
application. 

 

Figure 63 Send To  

To see the options on the Send To menu, you must have the appropriate software installed 
on your PC. To see the Send to Email option, you first need to set up your email account 
settings on the Setup Email tab. 

NOTE: If you cannot see the Word or Excel option, but you do have Microsoft® Office 
installed on your PC, refer to the Spectrum Administrator’s Guide (part number 
L1050095) for troubleshooting information. 

You can also use the Send To menu to send your data to Bio-Rad’s KnowItAll Informatics 
System®, if you have the software installed. 

To display the Setup Email tab: 

 Select Export and Email from the Setup menu, and then select the Setup Email tab. 

 

Figure 64 Setup Email tab 

When you select Send To Email, the contents of the current window are added to an email 
form as an attachment. You can then enter the recipient’s email address, type your message 
and add any additional attachments before sending the message. 
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Reporting 

You can generate a report of your data in two ways: 

• Using the Report option from the File menu 

• Using an Output step in a Macro. 

NOTE: Reports are also generated using customized templates for Instrument Verification 
Checks and Ready Checks. See Ready Checks and Instrument Verification on page 86 
for more information. 

Report 

You can generate a report of your results at any time using the Report option from the File 
menu (Figure 63).  

 

Figure 65 Report dialog 

You can generate a report as *.rtf (rich text format) or *.pdf (portable document format) 
files and then save the report to a file, print it, or attach it to an email. 

NOTE: To see the Email Report option you must set up your email account settings on the 
Setup Email tab. 

The default Folder for Reports, here C:\pel_data\reports, was defined during the software 
installation. To change the default location, browse to a new folder. 
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Reports are generated using a template. You can select the sections you want to include in 
your report on the Report Edit tab. The items listed depend on the template selected. In the 
example shown in Figure 64, we have included the spectrum and the Compare results. 

 

Figure 66 Example report showing Compare result 

NOTE: You can also create a report as part of an Output step in a Macro. See the Macros 
tutorial and the Spectrum on-screen help for more information.  

Printing 

The Print and Print Preview options from the File menu send the contents of the current 
window displayed to the printer. Print Preview enables you to change your Page Setup, such 
as the paper size and orientation, before printing. 

NOTE: You can also print your data as a Report. 
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Instrument Settings 

If you want to change any of the default instrument settings, use the Setup Instrument tabs. 

 Select Instrument from the Setup menu to display the Setup Instrument tabs.  
To amend any value, select the parameter and then enter your new value, or select a 
value from the drop-down list.  

 

Figure 67 Setup Instrument Basic tab 

On the Setup Instrument Basic tab you can set the Start and End points of the scan range 
(by default in wavenumbers, but the abscissa units can also be set to nanometers or 
microns) and the Accumulations required, either as a number of scans, or as a length of 
time. You can also set the Resolution (in cm−1).  

You can also save and export instrument settings as *.set files for use in an Instrument 
Setup step in a Macro, or for transferring instrument settings between compatible 
instruments or between PCs, using Load and Save (Figure 65). 

Refer to the Spectrum tutorial Setting Up Your Instrument for more information on the 
Setup Instrument tabs, or refer to the appropriate topic for each tab in the Spectrum  
on-screen Help. 

NOTE: The Instrument Settings and Measurement toolbars can be configured to contain any 
setting available on the Setup Instrument tabs. 
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Changing the Resolution 

The Resolution setting is on the Setup Instrument Basic tab in Spectrum software (Figure 27). 

The resolution achievable in the instrument is determined by both the optical path difference 
in the interferometer and the beam divergence in the interferometer as seen by the detector. 
The Spectrum Two N spectrometer has a slot in the double-sided slide holder that enables 
you to insert a J-stop card before the sample (Figure 66).  

 

Figure 68 The double-sided slide holder 

J-stop cards set the upper limit to the resolving power (wavenumber/resolution) of the 
instrument by limiting the beam divergence. Hence, to achieve a resolution defined by the 
optical path difference (for example, 2 cm−1), as specified by the Resolution on the Setup 
Instrument Basic tab, a certain beam divergence is required and this is dictated by a given  
J-stop aperture diameter. J-stop cards are provided with Spectrum Two to enable 8, 4, 2 and 
1 cm−1 resolutions at 7200 cm−1.  

At a given wavenumber, the smaller the J-stop aperture, the finer the resolving power 
(assuming we are not limited by the optical path difference scanned by the interferometer). 
Hence, at 7200 cm−1 the 4 cm−1 J-stop card has a given diameter to deliver a resolving 
power of 1800. However, this same diameter may be used achieve 2 cm−1 at 3600 cm−1 or 
1 cm−1 at 1800 cm−1, providing that the optical path difference (set by the Resolution 
setting in the software) is set up appropriately. This can be useful where higher resolution is 
needed for low-energy situations, where it is only required to achieve resolutions up to lower 
wavenumber ranges. For example, using a 4 cm−1 J-stop to deliver 2 cm−1 resolution to 
3600 cm−1 only can enable higher signal-to-noise to be achieved (or permit shorter scan 
times) than using the 2 cm−1 J-stop card which would deliver 2 cm−1 resolution to 7200 cm−1. 

For normal operation at 4 cm−1 resolution as defined in the software, the Spectrum Two 
optics are designed to deliver an approximately 4 cm−1 instrument lineshape and specified 
wavenumber calibration without the use of the 4 cm−1 J-stop card (assuming the sample is 
not acting to restrict the beam). However, when highest wavenumber accuracy in direct 
transmission measurements is required, we recommend use of the optional AVI function with 
the 4 cm−1 J-stop card installed. This ensures the purest lineshapes at higher wavenumbers.  

NOTE: This assumes the sample is not restricting the beam and itself forming an effective  
J-stop. For highest accuracy work, we recommend to always ensure the sample is 
larger than the J-stop diameter. 

Sample slide holder 
J-stop card holder 



Getting Started with Spectrum Software . 79 

If you change the Resolution (cm−1) in Spectrum software with the slide holder installed in 
the sample compartment, a message will be displayed on the Setup Instrument BeamPath 
tab, and in the Status Bar, prompting you to insert one of the J-stop cards in the slide holder, 
or to remove any external J-stop card (Figure 67).  

 

Figure 69 Setup Instrument BeamPath tab 

The J-Stop size selected and the Resolution will be recorded as part of the Instrument 
Settings on the History tab of the spectrum. See the Spectrum on-screen help for more 
information. 

NOTE: For accessories other than the Slide Holder, you cannot insert a J-stop card. 
Therefore, increasing the resolution (resolution values below 2 cm−1) decreases the  
J-Stop Wavenumber, the maximum wavenumber at which you can achieve that 
resolution.  
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Component Checks 

The Component Checks are run automatically the first time you connect to the instrument. 
You can select to run component checks each time you connect to the instrument, on 
demand, or after a scheduled number of days on the Setup Laboratory Actions tab in the 
Laboratory Scheduler. Refer to the Spectrum on-screen Help for details. 

To run the Component Checks on demand: 

 Select Component Checks from the Instrument Checks sub-menu on the 
Measurement menu. 
The Component Checks dialog is displayed (Figure 68) and the tests are run. Each item 
is assigned a pass  or fail status . If the Component Checks identify a problem, 
further information or instructions will be provided in the Recommended Action section. 

 

Figure 70 Component Checks dialog 
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If the Component Checks identify that a user-maintainable part needs to be replaced, for 
example the source or desiccant, a link to the appropriate Replacement Wizard will be 
displayed (Figure 69). The Replacement Wizard will provide step-by-step instructions for 
replacing the part. Refer to the relevant section in Maintenance, starting on page 95, for 
more information. 

 

Figure 71 Component Checks dialog with source failure 

If the Component Checks identify a problem that may require investigation by a PerkinElmer 
Service Representative, refer to IRTechSupport@PERKINELMER.COM for assistance. 

If your PerkinElmer Service Engineer requires the log files created during the Component 
Checks, these are located at:  

• C:\ProgramFiles\PerkinElmer\ServiceIR\Component Checks\[Instrument Serial Number]  

OR 

• C:\ProgramFiles (x86)\PerkinElmer\ServiceIR\Component Checks\[Instrument Serial 
Number] 

for Windows XP/Windows 7 (32-bit) or Windows 7 (64-bit), respectively, where “C:” is the 
drive on which Spectrum software is installed. 
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Humidity Shield 

The humidity shield displays the current internal humidity of the spectrometer as measured 
by the humidity sensor inside the instrument.  

 Select Humidity Shield from the Measurement menu. 
The Humidity Shield dialog is displayed. 

 

Figure 72 Humidity Shield  

The information your humidity shield may display is listed in Table 3. 

Table 3 Humidity Shield status information 
 

Status Appearance Humidity 
Range 

Action Required 

Normal 0% <10% No action is required. 

 

High 20% 20–39% Desiccant change is recommended. 

 

Critical 40% ≥40% Replace the desiccant immediately to avoid 
instrument damage. 

If the humidity of your instrument reaches high or critical levels, the humidity sensor will 
display a warning message on the Status bar. 

  

Figure 73 Humidity sensor High and Critical warning messages  

NOTE: The humidity is also checked during the Component Checks. 
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The expiry date of the desiccant is based on the date the desiccant was last changed. It 
gives an indication of when the desiccant is expected to expire in normal conditions (up to 
five years). However, if your spectrometer is used or stored in an environment that has high 
levels of humidity you are advised to use the Humidity Shield to check the humidity of your 
instrument more frequently.  

To replace your desiccant you must use the Desiccant Replacement Wizard: 

 Click Replace desiccant.  
Follow the instructions on-screen. See Changing the Desiccant on page 98 for more 
information. 



84 . Spectrum Two N User's Guide 

Power Save Mode 

There are two ways you can put the instrument into a low-power mode: by pressing the 
power button on the front of the instrument or using the Power Save option in Spectrum 
software. 

NOTE: If the power to the instrument is suddenly cut off, for example by disconnecting the 
power supply, then you must connect the instrument to Spectrum software once the 
power supply is re-established to apply any Power Save mode settings. 

Using the button on the front of the instrument 

To put the instrument in low-power mode: 

 Press the Power On button on the front of the instrument (Figure 72) for approximately 
2 seconds until the LED turns from solid green to solid yellow.  
If you are connected to the instrument in Spectrum software, the Setup Instrument tabs 
Measurement menu and the Scan toolbars will be disabled. 

 

Figure 74 Power button on the instrument 

NOTE: If you use the Power button to put the instrument in low-power mode, the 
instrument will not be under software control. Consequently, any scheduled Power 
Save mode event in Spectrum software will not occur until after you have manually 
repowered the instrument. 

To power up the instrument again: 

 Press the Power button on the front of the instrument for approximately 2 seconds until 
the LED turns green. 
The instrument will take a couple of minutes to initialize. When the initialization is 
complete, and if you were connected to the instrument previously, the Setup 
Instrument tabs and Scan toolbars will be available. 
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Using Power Save Mode in Spectrum software 

You can use the Power Save option in Spectrum software to control when the instrument is 
in standby or powered up. You can set up the Power Save options independently for each 
day of the week. 

 Select Laboratory Scheduler from the Setup menu, and then select the Setup Power 
Save tab (Figure 73). 
Enter the Power On and Power Off times for each day. 

 

Figure 75 Setup Power Save tab 

The instrument will enter Power Save mode at the scheduled time.  

NOTE: Shortly before the instrument enters Power Save mode, a message will be displayed. 
You then have the option to postpone the event for up to 2 hours. 

The instrument’s internal clock is synchronized with the last PC to make a connection. To 
update the clock, either after manually changing the PC time, or after an event such as 
Daylight Savings Time, connect to the instrument using either Spectrum, Spectrum ES or 
AssureID. 

To put the instrument in Power Save Mode at any time: 

 Select Power Save Mode from the Measurement menu. 

During Power Save  

When the instrument is placed in Power Save Mode the LED on the front of the instrument 
will flash yellow to indicate that the instrument will start up again at the scheduled time. 

Power on event 

At the scheduled time, or if the Power On button is pressed, the LED turns from flashing 
yellow to solid green. The instrument will then take a couple of minutes to initialize. When 
the initialization is complete, and if you were connected to the instrument previously, the 
Setup Instrument tabs and Scan toolbars will be available. 

NOTE: If you use the Power button on the front of the instrument to put the instrument in 
low-power mode, the instrument will not be under software control. Consequently, 
any scheduled Power Save mode event in Spectrum software will not occur until after 
you have manually repowered the instrument. 
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Ready Checks and Instrument Verification  

There are three types of Instrument Checks in Spectrum software (Figure 74): 

• Component Checks, which check that the components of your instrument are working. 
For more information refer to Component Checks on page 80. 
You are advised to run these each time you start your instrument. 

• Ready Checks, which check that your system – that is, instrument and accessory – are 
fit-for-purpose. 
You are advised to run appropriate Ready Checks before starting your sample analysis. 
For the Contamination Check, this would be before preparing each sample. 
A Ready Check is specific to the current instrument configuration. 

• Instrument Verification, which provides basic checks to determine that your instrument 
is performing within parameters. 
These tests should be performed according to the working practices of your laboratory, 
but usually weekly, or monthly, would be appropriate. 

 

Figure 76 Instrument Checks sub-menu of the Measurement menu 

Ready Checks 

A Ready Check demonstrates that an aspect of the performance of your complete system, 
including sampling accessory, is fit-for-purpose. When defining tolerances for Ready Checks, 
you should consider what the definition of that is for your individual application.  
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 To run the tests, select Instrument Checks and then Ready Checks from the 
Measurement menu, and then select the Ready Check you want to run. 
You can run the ready checks individually or run all the Ready Checks selected on the 
Setup Ready Checks tab using the Run Selected option. Follow the instructions  
on-screen. 

 

Figure 77 Ready Checks dialog 

• The Contamination Check is applicable to sampling accessories that include a 
component, such as a top plate, that may require cleaning between samples. The check 
compares a background spectrum taken after your sample has been removed with a 
reference background spectrum taken when the accessory was perfectly clean. The 
ratioed spectrum is then examined in absorbance for any sample residue.  
You require a suitable reference background spectrum and can enter details for up to 
three peaks that are characteristic of the possible contaminant.  

• The Quant Control Check enables you to verify your Quant Method before scanning your 
samples. The concentration of a control sample is calculated using the Quant Method, 
and compared with the known concentration. If it is within limits defined during setup, 
the check passes.  

• The Abscissa Check collects a background spectrum and then collects the spectrum of a 
polystyrene reference sample (either using the polystyrene reference in the filter wheel, 
or a polystyrene reference inserted in the slide holder). It then measures the 
wavenumber at the specified peaks. If the wavenumber value is within the tolerances 
defined during setup, the check passes.  

• The Throughput Check collects a spectrum and measures the ordinate value at each of 
the specified abscissa positions. If the measured ordinate value is above the lower limit, 
the check passes.  

• The Noise Check collects two background spectra and then measures the RMS (%T) 
and Peak-to-Peak (%T) noise over a range and report the baseline Trend. If the values 
are within limits defined during setup, the check passes.  

At the end of the tests a report will be generated (by default) containing the results. 

Refer to the Spectrum on-screen help for more information on setting up Ready Checks.  
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Instrument Verification 

You can run the basic Instrument Verification Checks without changing any settings. 
However, you can select further tests and modify the default values for each test. 

NOTE: Before performing any Instrument Verification tests you should remove any sampling 
accessory from the beam path. If your instrument does not have an internal filter 
wheel, then you will need the slide holder inserted in the beam path. 

 To run the tests, select Instrument Checks and then Instrument Verification Checks 
from the Measurement menu. 
Follow the instructions on-screen. 

 

Figure 78 Instrument Verification dialog 

The Abscissa Check collects a background spectrum and then collects the spectrum of a 
NIR polystyrene reference sample. It then measures the wavenumber at the specified 
peaks. If the wavenumber value is within the tolerances defined during setup, the check 
passes.   
The Ordinate check by default uses a reference card inserted in the slide holder. You 
can choose another reference material for the tests, but you will need to change the 
default settings. 
The Noise Check collects two background spectra and then measures the RMS (%T) 
and Peak-to-Peak (%T) noise over a range and reports the baseline Trend. If the values 
are within limits defined during setup, the check passes 
At the end of the tests a report will be generated (by default) containing the results. 

You can run up ASTM Level 0 tests, or tests that comply with the requirements of several 
national pharmacopoeias. Refer to the Spectrum on-screen help for more information on 
setting up Instrument Verification Checks.  
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Atmospheric (CO2/H2O) Suppression 

Atmospheric suppression, selected by default on the Setup Instrument Advanced tab 
(Figure 77), is an atmospheric correction routine. 

 

Figure 79 Setup Instrument Advanced tab in Spectrum 

This routine is more powerful than simple subtraction, overcoming the following issues: 

• Non-linearity due to resolution 

• The measured spectrum is temperature dependent 

• Lineshape and calibration are affected by J-stop and sample or accessory. 

When CO2/H2O is switched on, the software uses a single reference spectrum derived from 
high-resolution data and our understanding of the instrument to model the lineshape, then 
finds the current real instrument parameters by least-squares fitting to the measured 
spectrum. 

 

Figure 80 Correction of an MIR spectrum at 4 cm−1 resolution 
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AVI Correction 

If available for your current instrument and sampling configuration, AVI correction can be 
selected on the Setup Instrument Advanced tab in Spectrum (Figure 79). 

 

Figure 81 Setup Instrument Advanced tab in Spectrum 

The objectives of Absolute Virtual Instrument (AVI) correction are: 

• Consistent performance over time and between instruments 

• Traceability for all measurements. 

Although FT-IR spectrometers use a reference laser, the wavenumber calibration and 
lineshape are affected by differences in beam divergence and uniformity. This is true for all 
FT-IR spectrometers. Differences can occur between instruments, when using different 
sampling accessories and when components are changed. AVI enables calibration and 
lineshape to be maintained. 

The Absolute Virtual Instrument is an instrument with theoretical performance, such that the 
result of measuring a known sample on such an instrument can be predicted. So, if we 
measure with a real instrument and calculate the software transform to match the theoretical 
result, we can apply this transform to future measurements. 

The Absolute Virtual Instrument is defined by wavenumber calibration, instrument lineshape 
and ordinate accuracy. 

When AVI is switched on, the software measures the current instrument profile relative to an 
absolute standard (a methane cell) and an ideal lineshape function, and applies a correction.  
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Figure 82 Spectra of methane at 4 cm−1 resolution as measured (top) and with 
AVI (bottom) 

AVI correction can only be performed if an AVI Calibration has been set up for the current 
configuration and resolution.  

AVI Calibration 

To set up an AVI Calibration: 

 Select Standardize from the Measurement menu.  

OR 

Select AVI from the Adjustments Toolbox, accessed via the Setup Instrument 
Advanced tab.  
Follow the instructions on-screen. For further information, refer to the Spectrum  
on-screen Help file. 

 

Figure 83 AVI Calibration dialog prompting the user to insert the methane cell 



92 . Spectrum Two N User's Guide 

Exit Spectrum Software 

When you exit Spectrum software you can choose a Save Option appropriate for what you 
want to do next time you use Spectrum.  

If you want to continue working with the same data, or to collect more samples listed in your 
Sample Table, you can resume your session next time with all your data loaded. If you 
choose not to reload your data, you can make sure that any unsaved data is saved to the 
appropriate default location you chose at installation. 

To exit Spectrum: 

1. Select Exit from the File menu. 

OR 

Click the  at the top right of the Spectrum window. 
The Save Options dialog is displayed. 

 

2. Select whether to: 
Save unsaved datasets – save any unsaved data, and open Spectrum with your 
default settings and layout next time, which enables you to preserve your current 
workspace for when you next log on to Spectrum at this PC. 
Save for reload next time – save any unsaved data, and reload the current spectra, 
settings and layout next time, which enables you to carry on with your work from where 
you left off when you next log on to Spectrum at this PC. 
Exit without saving datasets – exit without saving any unsaved data, layout or 
settings information, which restores the default workspace when you next log on to 
Spectrum at this PC. 
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Maintenance 
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Overview 

This section covers the maintenance that can be carried out by a user. 

It describes: 

• Cleaning the spectrometer 

• Replacing the desiccant 

• Purging the sample area 

• Purging the instrument optics 

• Replacing the sample compartment windows 

• Replacing the source 

• Replacing the main board air filter. 

NOTE: You must use the appropriate Replacement Wizard in Spectrum, Spectrum ES or 
AssureID software to replace the source, desiccant or sample compartment windows, 
as described in this section. During the maintenance procedure, the internal 
temperature of the instrument is maintained to prevent the ingress and condensation 
of water vapor, which could damage the optics. 
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Cleaning the Spectrometer 

Clean the outside of the instrument using a damp cloth. If necessary, a mild detergent may 
be used. Before you clean the entire instrument, always perform a patch test on an 
inconspicuous area. 

Avoid spilling liquid into the instrument. Clean all external spills immediately.  
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Changing the Desiccant 
 

CAUTION 

 

 
ATTENTION 

Expect to change the desiccant in the spectrometer approximately every 
five years. Old, used desiccant releases moisture. 

In regions experiencing high humidity levels we recommend that you 
change the desiccant more often, and that you monitor the internal 
humidity of your instrument using the Humidity Shield (refer to page 82) 
regularly. 

Attendez-vous à changer le dessicant dans le spectromètre environ tous 
les cinq ans. Ancien, le dessiccateur utilisé libère de l'humidité. 

Dans les régions où le taux d'humidité est élevé, nous vous 
recommandons de modifier le déshydratant plus souvent et de surveiller 
l'humidité interne de votre instrument à l'aide de l'humidité (voir page 
81) régulièrement. 
 

The desiccant change interval is set in the Desiccant change due in (days) option on the 
Setup Instrument BeamPath tab in Spectrum software (Figure 82).  

 

Figure 84 Setup Instrument BeamPath tab in Spectrum 

If the desiccant change due date has passed, a warning will be displayed in the Status Bar 
and in the table on the Setup Instrument BeamPath tab. 

The warning is displayed until you update the software that the desiccant has been changed. 
To reset the desiccant change interval, select the current value, click Changed to clear any 
warning messages. 

You may also be prompted to change your desiccant during the Component Checks. 

To replace the desiccant, you will require the desiccant replacement kit (part number 
L1600244). The kit contains a wrench and two bags: one large and one small.  

Inspect the humidity indicator card in the plastic bag containing the larger of the two bags. If 
the card is pink it indicates moisture in the bag, and you should discard the desiccant pack. 
Only use the replacement desiccant bag if the indicator is blue. 
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CAUTION 

 
ATTENTION 

Old, used desiccant releases moisture and can cause high humidity 
levels inside the instrument resulting in catastrophic failure of KBr optics. 

Do not use damaged packs of desiccant. Make sure that the packs you 
use have not been left in contact with the air. 

Un dessiccateur usé libère de l'humidité et peut causer des niveaux 
élevés d'humidité à l'intérieur de l'instrument, entraînant une panne 
catastrophique de l'optique KBr. 

Ne pas utiliser de paquets endommagés de dessiccateur. Assurez-vous 
que les paquets que vous utilisez n'ont pas été laissés en contact avec 
l'air. 
 

The instrument must be switched on and you must be connected to the instrument in 
Spectrum, Spectrum ES or AssureID software. You can start the Desiccant Replacement 
Wizard from the Adjustments Toolbox or, if the Component Checks identify high humidity as 
a problem, by selecting Run Desiccant Replacement Wizard on the dialog. You can also 
start the wizard by clicking Replace desiccant on the Humidity Shield dialog. 

NOTE: In AssureID software, the Adjustments Toolbox is available from the Configure 
Instruments and Accessories group on the Tools menu. 

To replace the desiccant when connected to Spectrum software: 

1. Select Instrument from the Setup Menu. 
The Setup Instrument tabs are displayed. 

2. Select the Setup Instrument Advanced tab and then click Toolbox. 
The Adjustments Toolbox dialog is displayed. 
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3. Click . 
The Desiccant Replacement Wizard is displayed.  

 

4. Follow the instructions on-screen. 

When you have the completed the procedure the Desiccant change due in (days) is reset 
automatically to 1800 days. 
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Purging the Spectrometer 

Purge the sample compartment if you need to make sure that no residual water vapor or CO2 
peaks are visible in the spectrum. The connectors are on the underside of the instrument 
(Figure 83).  

 

Figure 85 Location of purge connectors 

Although connections are provided, under most circumstances you should not purge the 
optical system. The Spectrum Two instrument was purged and then sealed after 
manufacture. To purge the instrument you will need to break the seal on the instrument, 
which will invalidate your instrument warranty. 

You can purge with either dry air or nitrogen. Both remove water vapor; however, nitrogen is 
preferable because it also removes atmospheric carbon dioxide. 

A typical cylinder of dry nitrogen (or dry air) stores 6.26 m3 at 1.4 × 104 kPa (220 ft3 at 
2200 lbf/in2). Make sure that the gas is free of oil, water, or dirt particles larger than 25 µm 
(0.001 inch). 
 

 
WARNING 

 
 
 

AVERTISSEMENT 
 
 

Do not site the instrument in a poorly ventilated area if nitrogen will be 
used as a purge gas. 

Oxygen depletion in an enclosed space does not trigger a gasping 
reflex, and errors of judgment, confusion, or unconsciousness can 
occur in seconds and without warning. 
 

Ne placez pas l'instrument dans une zone mal ventilée si l'azote est 
utilisé comme gaz de purge. 

L'appauvrissement de l'oxygène dans un espace clos ne déclenche pas 
un réflexe gonflant, et des erreurs de jugement, de confusion ou 
d'inconscience peuvent se produire en quelques secondes et sans 
avertissement. 

 

Sample area 
purge connector 

Instrument purge 
inlet port 

Cable clip 

Instrument purge 
outlet port 

Opening for tubing  
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WARNING 

 
AVERTISSEMENT 

Do not use a flammable gas to purge the instrument. The spectrometer 
contains a hot source, and a fire or explosion will result. Only use 
clean, dry, oil-free nitrogen or air to purge the instrument. 

N'utilisez pas de gaz inflammable pour purger l'instrument. Le 
spectromètre contient une source d'énergie chaude, et un incendie ou 
une explosion entraînera. Utiliser uniquement de l'azote ou de l'air 
propre, sec, exempt d'huile pour purger l'instrument. 

 

 
WARNING 

AVERTISSEMENT 

Never connect the purge tubing directly to a gas cylinder or other high 
pressure supply; always use a pressure regulator and set the pressure 
to a maximum of 6.9 kPa (1 lbf/in2) before you start the flow. 

Ne jamais connecter le tube de purge directement à une bouteille de 
gaz ou à une autre alimentation haute pression; utilisez toujours un 
régulateur de pression et réglez la pression à un maximum de 6,9 kPa 
(1 lbf/in2) avant de commencer le débit. 

Purging the sample compartment 

A length of clear plastic tubing (1/4 inch internal diameter, part number L1600245) is 
provided to transfer the gas to the sample compartment purge connector. 

To connect the sample compartment purge: 

1. Disconnect from the instrument in your software, if applicable. 

2. Disconnect the instrument from the mains power and then remove any cables 
connected to the rear of the spectrometer. 

3. Remove any sampling accessories installed in the sample compartment. 
You will need to invert the instrument. 

4. Carefully, turn the instrument over to display the underside, placing the instrument on a 
soft surface. 

5. Locate the sample compartment purge connector shown in Figure 84. 

 

Figure 86 Sample compartment purge connector 

 

 

Sample compartment 
purge connector 

Tubing clip 

Outlet for tubing 
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6. Feed the tubing through the opening in the instrument baseplate, through the tubing 
clip and then push the end of the tubing onto the barbed purge connector. 

7. Connect the free end of the tubing to the gas regulator. 

NOTE: Ensure the regulator is set to a pressure not greater than 6.9 kPa (1 lbf/in2). 

8. Open the gas flow valve on the regulator until a flow rate of 4 L/minute 
(0.14 ft3/minute) is achieved. 
It will take about 2 minutes to fully purge the sample compartment. 

9. When you have finished work, turn off the gas supply. 

10. Disconnect the fitting from the instrument, if required, by easing the tubing off the 
purge connector. 

Purging the instrument 
 

CAUTION 

 
ATTENTION 

The Spectrum Two N instrument was purged and then sealed after 
manufacture. The bolts in the instrument purge connection ports are 
marked with tamper-proof paint. If you break the seals on the 
instrument you will invalidate your instrument warranty. DO NOT 
proceed unless you fully understand the implications of doing so.  

L'instrument Spectrum Two N a été purgé puis scellé après la 
fabrication. Les boulons dans les orifices de raccordement de la purge 
de l'instrument sont marqués d'une peinture inviolable. Si vous brisez les 
joints sur l'instrument, vous invaliderez la garantie de votre instrument. 
NE PAS continuer à moins que vous compreniez parfaitement les 
conséquences de le faire. 

In normal operation it should not be necessary to purge the instrument.  

To connect the instrument purge you will need the optional Instrument Purge Kit  
(part number L1600234). The kit contains tubing, two extenders and right-angled 
connectors, pliers and two blanking plugs to block the connectors when you have finished 
purging. 

1. Disconnect from the instrument in your software, if applicable. 

2. Disconnect the instrument from the mains power and then remove any cables 
connected to the rear of the spectrometer. 

3. Remove any sampling accessories installed in the sample compartment. 
You will need to invert the instrument. 

4. Carefully turn the instrument over to display the underside, placing the instrument on a 
soft surface. 

5. Locate the instrument purge inlet port shown in Figure 85.  

6. Using an M5 hexagonal key, unscrew and remove the bolt in the inlet port (Figure 85). 
Retain the bolt for future use. 

NOTE: The custom bolts contain an o-ring seal. 
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Figure 87 Instrument inlet purge port securing bolt 

7. Screw one of the straight connectors supplied into the instrument purge inlet port and 
tighten using the pliers supplied with the kit (Figure 86). 

 

Figure 88 Instrument purge inlet port straight connector 

8. Screw one of the right-angled connectors supplied into the inlet port and tighten using 
the pliers (Figure 87). 

 

Figure 89 Tighten the purge port right-angled connector 

9. Cut the tubing supplied into pieces of suitable length. 

10. Push the end of one piece of tubing onto the right-angled connector as shown in 
Figure 88. 

Instrument purge 
inlet port  
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Figure 90 Tubing connected to instrument purge inlet port 

11. Connect the free end of the inlet tubing to the gas regulator. 

NOTE: Ensure the regulator is set to a pressure not greater than 6.9 kPa (1 lbf/in2). 

12. Repeat steps 6–10 to connect the other piece of tubing to the instrument purge outlet 
port (Figure 89). 
Although you must remove the bolt from the outlet port before passing gas through the 
inlet port, it is not necessary to connect the outlet tubing if you do not need to vent the 
gas outside the operating environment. 

 

Figure 91 Tubing connected to instrument purge inlet port 

13. Feed the purge outlet tubing through the tubing clip and the outlet port and position it 
to vent to a suitable location (for example, a fume hood). 

14. Open the gas flow valve on the regulator until a flow rate of 2 L/minute 
(0.07 ft3/minute) is achieved. 
It will take about 10 minutes to fully purge the instrument optics. 

15. When you have finished work, turn off the gas supply. 

16. Release the tubing from the instrument purge inlet port and, if fitted, from the purge 
outlet port. 
To release the tubing, pull back the spring fitting on the connector and then gently pull 
the tubing out. 

17. For a temporary seal, fit the blanking bolts supplied into the right-angled connectors. 
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OR 

If you have finished purging your instrument, replace the bolts you removed in Step 6. 

NOTE: If you have mislaid the bolts fit the blanking bolts instead, then contact PerkinElmer 
Customer Care to obtain replacements. 



Maintenance . 107 

Replacing the Source  

If there is a Recommended Action to replace the source in the Component Checks, you will 
require the source replacement kit (part number L1390110). The kit contains a replacement 
source and source-doubling mirror assembly, and a 2.5 mm hexagonal wrench. 

To replace the source, the instrument must be switched on and you must be connected to 
the instrument in Spectrum, Spectrum ES or AssureID software. You can start the Source 
Replacement Wizard from the Adjustments Toolbox or, if the Component Checks identify 
Source Failure as a problem, by selecting Run Source Replacement Wizard on the dialog.  

NOTE: In AssureID software, the Adjustments Toolbox is available from the Configure 
Instruments and Accessories group on the Tools menu. 

 

CAUTION 

 
ATTENTION 

The source element is brittle and can be broken if not handled properly. 
Be careful when removing and installing the source. 

Before starting the source replacement procedure, ensure that you have 
the source replacement kit available to minimize the amount of time that 
the source compartment is open. 
 
L'élément source est fragile et peut être brisé s'il n'est pas manipulé 
correctement. Faites attention lorsque vous retirez et installez la source. 

Avant de commencer la procédure de remplacement de la source, 
assurez-vous que le kit de remplacement source est disponible pour 
minimiser le temps pendant lequel le compartiment source est ouvert. 

To replace the source: 

1. Select Instrument from the Setup Menu in Spectrum software. 

The Setup Instrument tabs are displayed. 

2. Select the Setup Instrument Advanced tab and then click Adjustments Toolbox. 

The Adjustments Toolbox dialog is displayed. 
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3. Click . 
The Source Replacement Wizard is displayed.  

 

4. Follow the instructions on-screen. 

5. When you have completed the procedure, we recommend that you run the Component 
Checks to confirm that your instrument is working correctly. 

6. Allow the source temperature to stabilize for approximately 2 hours before using the 
instrument.  

NOTE: If you are using the AVI correction, you will need to run a new AVI calibration after 
replacing the source. 
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Installing/Replacing Windows 

The Spectrum Two N spectrometer is available with CaF2 sample compartment windows. You 
should only need to replace them if they are broken. 

To replace the windows you will require the appropriate window replacement kit: part 
number L1390104. The window replacement kits contain two replacement windows with 
seals, one for each side of the sample compartment, and a 1.5 mm hexagonal wrench. 

 

CAUTION 
 

ATTENTION 

Be careful not to get moisture on the optical surface of the window. Do 
not touch or breathe on the optical surface of the window. 

Veillez à ne pas humidifier la surface apicale de la fenêtre. Ne pas 
toucher ou respirer sur la surface optique de la fenêtre. 

The instrument must be switched on and you must be connected to the instrument in 
Spectrum, Spectrum ES or AssureID software. 

NOTE: In AssureID software, the Adjustments Toolbox is available from the Configure 
Instruments and Accessories group on the Tools menu. 

To replace the windows when connected to Spectrum software: 

1. Select Instrument from the Setup Menu in Spectrum software. 
The Setup Instrument tabs are displayed. 

2. Select the Setup Instrument Advanced tab and then click Toolbox. 
The Adjustments Toolbox dialog is displayed.  

3. Click .

 
The Window Replacement Wizard is displayed.  
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4. Follow the instructions on-screen. 
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Replacing the Main Board Air Filter 

If your instrument is used regularly in a dusty environment, the main board air filter may 
become blocked. If it does, you may notice that your instrument takes longer to stabilize. To 
replace the main board air filter you will need the replacement main board air filter (part 
number L1601717). 

NOTE: Alternatively, the filter is washable in water. Ensure it is thoroughly dry before 
replacing it in the instrument. 

1. Disconnect from the instrument in your software, if applicable. 

2. Disconnect the instrument from the mains power and then remove any cables 
connected to the rear of the spectrometer. 

3. Remove any sampling accessories installed in the sample compartment. 
You will need to invert the instrument. 

4. Carefully, turn the instrument over to display the underside, placing the instrument on a 
soft surface (Figure 90). 

 

Figure 92 Location of the main board compartment 

Main board 
compartment  
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5. Using a Philips-type, PZ No 1 screwdriver, undo the screws securing the main board 
compartment cover to the instrument and remove the cover (Figure 91). 
Retain the screws and store in a safe place. 
 

CAUTION 
 

ATTENTION 

The main board contains static-sensitive devices. Do not touch the main 
board or electrical components when changing the main board air filter.  

La carte principale contient des périphériques statiques. Ne touchez pas 
la carte principale ou les composants électriques lors de la modification 
du filtre à air de la carte principale. 

 

 

Figure 93 Remove the securing screws 

6. Locate the used filter (Figure 92). 

 

Figure 94 Location of the filter 

Used filter  
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7. Remove the used filter (Figure 93). 

 

Figure 95 Remove the used filter 

8. Slot in the replacement filter, ensuring that it is flat. 

9. Replace the compartment cover, and secure with the screws retained in Step 2. 
Ensure that the white main board cable shown in Figure 94 is not trapped when you 
replace the compartment cover, but passes through the cut-out in the instrument 
housing. 

 

Figure 96 Replace the compartment cover 

NOTE: If the compartment cover is not orientated correctly you will not be able to insert all 
the screws.  

White cable  
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Additional Parts 

The following optional parts, replacement parts and upgrades are available: 

Optional parts 
 
Part Number Description 

L1600238 Spectrum Two N Portability Pack 

L1600233 Spectrum Two N Battery Pack (includes a 12 V car adaptor) 

L1600246 Spectrum Two N Wireless Router Kit 

L9004128 Spectrum Two N 12 V Car Adaptor 

L9004199 Spectrum Two N Carry Case 

N0782060 Spectrum Two N Bench 

L9004196 Barcode Reader 
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Replacement parts 
 
Part Number Description 

L1390110 Spectrum Two N Source Replacement Kit 

L1600244 SP2 Desiccant Replacement Kit 

L1390104 Spectrum Two N CaF2 Window Replacement Kit 

L1601717 SP2 Main Board Air Filter 

L9004169 USB Cable 

L1200466 Ethernet Crossover Cable  

L1390271 Kit-SP2N J-stop cards 

L9002298 SP2 Power Supply 

L1600216 SP2 Sample Compartment Lid 

 





Appendices 
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Appendix 1: Connector Details 
 Port Description Connector 

Type 
Voltages Maximum 

Currents 

A USB 

 

This is the standard interface 
between the PC and the 
instrument. 

USB 
(Type B) 

– – 

B ETHERNET 

 

100 Base-T Ethernet 
connector. This is the standard 
interface between a Local Area 
Network (LAN) and the 
instrument. It can also be used 
to connect direct to the PC. 

Ethernet <5 V <100 mA 

C EXT 
DETECTOR 

This port enables to you power 
the optional Wireless Router or 
connect an external accessory. 

Female high-
density 15-way  
d-connector; 
±CAN-bus; 
 i-button 

+12 V 
output 

500 mA 

−12 V 
output 

100 mA 

Analog 
inputs 

±12 V max. 

1K5 ohm 

 

0 V  

E DC Power  The DC power port is used to 
connect the spectrometer to 
the power supply. You can use 
the mains power supply 
adaptor and cable supplied, or 
you can use the optional 
battery pack or car adaptor. 

 18 V 3 A 
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Appendix 2: Instrument Performance 
Validation Kits 

The NIR Polystyrene Re-Calibration TRM Kit (part number L1250475) contains a polystyrene 
reference sample for use when calibration validity of original TRM expires.  

Spectrum 10 STD and Spectrum ES Data Manipulation Validation and Suitability CD (part 
number L1050071) 
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Appendix 3: Decontamination and Cleaning 

Before using any cleaning or decontamination methods except those specified by 
PerkinElmer, users should check with PerkinElmer that the proposed method will not damage 
the equipment. 

Decontamination 

Customers wishing to return instrumentation and/or associated materials to 
PerkinElmer for repair, maintenance, warranty or trade-in purposes are advised 
that all returned goods must be certified as clean and free from contamination. 

The customer’s responsible body is required to follow the “Equipment Decontamination 
Procedure” and complete the “Certificate of Decontamination”. These documents are 
available on the PerkinElmer public website:  

http://www.perkinelmer.com/Content/technicalinfo/dts_instrumentdeconprocedure.pdf 

Alternatively, if you do not have access to the internet contact Customer Care: 
 

Customer Care USA: 1 800 762 4000 (inside the USA) 

(8:30 a.m. – 7 p.m. EST) (+1) 203 925 46 02 (outside the USA) 

Customer Care Canada: 800 561 46 46 
customercareca@perkinelmer.com 

 

Customer Care China: 800 820 50 46 
customercarecn@perkinelmer.com 

 

Customer Care EU: 0800 40 858 
benelux@perkinelmer.com 

Belgium 

 0805 111 333 
cc.france@perkinelmer.com 

France 

 0800 181 00 32 
cc.germany@perkinelmer.com 

Germany 

 0800 90 66 42 
cc.italy@perkinelmer.com 

Italy 

 8000 99 164  
atencionalcliente@perkinelmer.com 

Spain 

 080089 60 46 
cc.uk@perkinelmer.com 

UK 

If you are located outside these regions, please call your local PerkinElmer sales office for 
more information. 

Cleaning the Instrument 

Exterior surfaces may be cleaned with a soft cloth, dampened with a mild detergent and 
water solution. Do not use abrasive cleaners or solvents. 

http://www.perkinelmer.com/Content/technicalinfo/dts_instrumentdeconprocedure.pdf
mailto:customercareca@perkinelmer.com
mailto:customercarecn@perkinelmer.com
mailto:benelux@perkinelmer.com
mailto:cc.france@perkinelmer.com
mailto:cc.germany@perkinelmer.com
mailto:cc.italy@perkinelmer.com
mailto:atencionalcliente@perkinelmer.com
mailto:cc.uk@perkinelmer.com
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Appendix 4: WEEE Instructions for PerkinElmer 
Products 

 or  

A label with a crossed-out wheeled bin symbol and a rectangular bar indicates that the 
product is covered by the Waste Electrical and Electronic Equipment (WEEE) Directive and is 
not to be disposed of as unsorted municipal waste. Any products marked with this symbol 
must be collected separately, and in accordance with the regulatory guidelines in your area. 

The objectives of this program are to preserve, protect and improve the quality of the 
environment, protect human health, and utilize natural resources prudently and rationally. 
Specific treatment of WEEE is indispensable in order to avoid the dispersion of pollutants into 
the recycled material or waste stream. Such treatment is the most effective means of 
protecting the customer’s environment. 

The requirements for waste collection, reuse, recycling, and recovery programs are set by 
the regulatory authority at your location. Contact your local responsible person (such as your 
laboratory manager) or authorized representative for information regarding applicable 
disposal regulations. 

See the PerkinElmer web address below for information specific to PerkinElmer products, and 
contact details for the Customer care department in your region. 
 
Web address:    
www.perkinelmer.com/WEEE 

Products from other manufacturers may also form a part of your PerkinElmer system. These 
other manufacturers are directly responsible for the collection and processing of their own 
waste products under the terms of the WEEE Directive. Please contact these manufacturers 
directly before discarding any of their products. 

Consult the PerkinElmer web site (above) for manufacturer’s names and web addresses. 
 

 
 
 

 
 
 
 
 
 
 
 
 
 

http://www.perkinelmer.com/WEEE
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Appendix 5: Calibration Procedure for Optical 
Attenuators 
Calibration of optical attenuators involves collecting spectra with and without the attenuator 
in the optical path and computing the corresponding attenuator correction factor. In order to 
prevent detector saturation a sample will need to be present in the optical path such that in 
the absence of the attenuator in the optical path the detector is within the linear range of 
operation. Calibration of attenuators is required when the attenuator is required to collect a 
background scan but is not required for collection of sample scan or a different attenuator is 
used for collection of background and sample scans. If the collected spectra are not 
corrected for the use of an optical attenuator the resulting spectrum will not be an accurate 
representation of the sample’s optical properties. The calibration procedure for the optical 
attenuator is as follows: 

1. Place sample in sample compartment and collect a Background scan. 
Sample of choice should be sufficiently absorbing such that the detector is not saturated 
without use of the optical attenuator. When the attenuator is in place sufficient light 
must be transmitted to collect a spectrum. 

2. After collection of Background scan, place the optical attenuator in the designated 
holder. Do not remove the sample from Step 1 from the sample compartment. 

3. Collect a Sample scan with sample and optical attenuator in the optical path.  

4. Process the resulting Sample scan to units of % Transmittance.  
The resulting % Transmittance spectrum is the actual percent transmittance value of 
the optical attenuator. For samples having significantly absorbing spectral features, the 
percent transmittance of the optical attenuator should be taken as the value at 
maximum signal. 

 

𝐴𝐴𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡 𝐶𝐶𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝐶𝐶𝑡𝑡𝐶𝐶𝑡𝑡𝑡𝑡 𝐹𝐹𝑡𝑡𝐶𝐶𝑡𝑡𝑡𝑡𝑡𝑡 =
% 𝑇𝑇𝑡𝑡𝑡𝑡𝑡𝑡𝑇𝑇𝑇𝑇𝐶𝐶𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝐶𝐶𝑡𝑡 𝑡𝑡𝑜𝑜 𝐴𝐴𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡

100
 

 
Correction of a singlebeam spectrum for the use of an optical attenuator is 
accomplished using the following equation: 

𝐶𝐶𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝐶𝐶𝑡𝑡𝑡𝑡𝐶𝐶 𝑆𝑆𝐶𝐶𝑡𝑡𝑔𝑔𝑔𝑔𝑡𝑡𝑔𝑔𝑡𝑡𝑡𝑡𝑇𝑇 𝑆𝑆𝑆𝑆𝑡𝑡𝐶𝐶𝑡𝑡𝑡𝑡𝑡𝑡𝑇𝑇 =
𝑈𝑈𝑡𝑡𝐶𝐶𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝐶𝐶𝑡𝑡𝑡𝑡𝐶𝐶 𝑆𝑆𝐶𝐶𝑡𝑡𝑔𝑔𝑔𝑔𝑡𝑡𝑔𝑔𝑡𝑡𝑡𝑡𝑇𝑇 𝑆𝑆𝑆𝑆𝑡𝑡𝐶𝐶𝑡𝑡𝑡𝑡𝑡𝑡𝑇𝑇
𝐴𝐴𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡 𝐶𝐶𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝑡𝐶𝐶𝑡𝑡𝐶𝐶𝑡𝑡𝑡𝑡 𝐹𝐹𝑡𝑡𝐶𝐶𝑡𝑡𝑡𝑡𝑡𝑡

 

 
Physical deformations of the optical attenuator will impact its optical properties. If the 
optical attenuator becomes deformed, the purchase of a new attenuator is 
recommended. 
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